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Introduction

License Agreement
HIGHWAY CAPACITY SOFTWARE™ (HCS2024 ™) AND TRANSYT-7F™

HCS2024™ END USER LICENSE AGREEMENT
Copyright © 2023 University of Florida. All rights reserved.

This is an agreement between you and the University of Florida Board of Trustees for the benefit of the McTrans
Center.

BY USING THE SOFTWARE PROGRAMS WITHIN THE ELECTRONIC TRANSMITTED PACKAGE OR DIRECT
DOWNLOAD (“SOFTWARE”), YOU AGREE TO BE BOUND BY THE TERMS OF THIS LICENSE AGREEMENT.
DO NOT USE THE SOFTWARE WITHOUT FIRST READING AND UNDERSTANDING THE TERMS OF THIS
LICENSE AGREEMENT.

If you do not agree with the terms of this license, discontinue use, delete, and/or return the unused Software
immediately to the distributor from which it was obtained.

1. LICENSE: In consideration of the required license fee, the University of Florida McTrans Center (hereinafter
called “McTrans”) hereby grants you (hereinafter called “End User”) a nonexclusive license to use the enclosed
HIGHWAY CAPACITY SOFTWARE (HCS2024) (hereinafter called “Software”) as described in the applicable
portion of section 3 for a period in which the End User pays the subscription fee established by McTrans.

2. OWNERSHIP: This license is not a sale of the Software; it is a license to use the Software under the terms of
this License Agreement.

3. USE: The Software is licensed to End Users for a particular use, depending on the particular license that is
designated on order and described in this Section.

a. Single Office License. The End User may use the Software on any number of computers within the End User’s
immediate office, defined as a single organizational unit with a unique function, comprising one or more contiguous
rooms in a single location. All persons using the Software are also End Users. End Users may also use the Software
on portable computers, such as laptops, while on official travel and on home computers, AS LONG AS ALL SUCH
USE IS ON BEHALF OF THE OFFICE FOR WHICH THIS SOFTWARE LICENSE WAS PURCHASED. This
Software License does not authorize the use of the Software at any offices related to that single organizational unit
but not located at the same geographic location, even if the Software is stored on a portable computer. If you have
any questions as to the validity of your End User License, contact McTrans. The End User may use the Software
directly on the computer that has been installed. The end User may not use the Software remotely via any
technology, such as a remote desktop (see section 4). The End User should consult with section 13 of this EULA
on other restrictions for the Software's use.
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b. Academic License. The End User may use the Software only within a laboratory within the End User’s immediate
school, which is defined as a single school unit having a unique function, comprising one or more contiguous rooms
in a single location, up to the permitted (purchased) number of copies, provided the use is supervised in a classroom
setting for teaching or research purposes, and appropriate protection is in place against students copying the
Software and taking it out of the lab. The responsibility for ensuring this protection of the Software rests with the
End User. Multiple laboratories require multiple licenses. The Software may not be installed or used on any
computer outside of the licensed laboratory under the Academic License, including (but not limited to) any office,
home, networked, or portable computer. If you have any questions as to the type or validity of your End User
License, contact McTrans. The End User may use the Software directly on the computer that has been installed.
The End User may not use the Software remotely via any technology, such as a remote desktop (see also section
4). The End User should consult with section 13 of this EULA on other restrictions for the Software's use.

c. Single Computer License. The End User may use the Software on a single computer, a desktop, a PC, or a
portable laptop. All persons using the Software are also End Users. The End User may use the Software anywhere,
such as a business office, home office, travel, etc. The End User should consult with section 13 of this EULA on
other restrictions for the Software's use. End User is only allowed to use the Software directly on the computer that
has been installed. End User may not use the Software remotely via any technology (see also Section 4), such as
remote desktop.

WARNING! If this license is a Single Office or Single Computer License for use in traffic and transportation
applications, the Software may not be used for classroom or workshop instruction without the express, written
consent of McTrans. (Contact McTrans for an Academic License.) If this license is an Academic License for use in
training or educational applications, the Software may not be used for traffic and transportation applications or other
similar purposes without the express, written consent of McTrans. (Contact McTrans for an Applications License.)

4. VIRTUALIZATION AND REMOTE ACCESS: The End User may not use this Software in a virtualized
environment. All installations under any available license types discussed in section 3 should be performed on a
physical computer such as a desktop, PC, or laptop. The End User may use the Software directly on the computer
that has been installed. End User may not use the Software remotely via any technology, such as remote desktop.

VIRTUALIZATION FOR VIRTUAL CLASSROOMS: Under academic license, the End User may ask permission to
utilize a virtual environment to install and use the Software only with written consent from McTrans.

5. NETWORK USE: No network use is permitted, including but not limited to using the Software either directly or
through commands, data, or instructions from or to a computer not already licensed and part of the internal network
for Internet or web hosting services or by any user not licensed to use this copy of the Software through a valid
license from McTrans. The Software is not designed for network use, and such use is not supported. McTrans is
not able to provide technical support for issues resulting from network incompatibilities.

6. COPY RESTRICTIONS: Unauthorized copying, distribution, or dissemination of the Software is expressly
prohibited. End User may be held legally responsible for any copyright infringement that is caused, encouraged, or
enabled by failure to abide by the terms of this license. Subject to these restrictions, the End User may make copies
of the Software for backup purposes and for use of the Software on any computers located within its office complex,
as described in paragraph 3. Under no circumstances may the Software or associated printed documentation be
copied for sale, distribution, or dissemination, except as provided in paragraph 3, without the express, written
consent of McTrans. End User may reproduce the associated documentation as necessary to use within the
geographic location for which the license is granted. End User may not modify, adapt, translate, reverse engineer,
decompile, disassemble, or create derivative work from the Software or any associated written materials without
the prior written consent of McTrans. ANY SUCH ACTIVITY OR PRODUCT BECOMES THE PROPERTY OF
McTRANS.

7. TRANSFER RESTRICTIONS: The Software is licensed only to the End User, and this License Agreement may
not be assigned or transferred to anyone without the prior written consent of McTrans. Any authorized transferee
of this License Agreement shall be bound by the terms of this License Agreement. End User may not transfer,
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assign, rent, lease, sell, or otherwise dispose of the Software except as expressly provided in this License
Agreement.

8. REGISTRATION AND SUPPORT: This license is automatically registered to the person or entity that purchased
it. If the End User wishes to change the registration, he or she must provide in writing the registration information.
McTrans may, from time to time, revise or update the Software to correct bugs or add minor improvements. McTrans
will supply, at its discretion, minor updates to the End User without additional charge and will provide reasonable
telephone or email support to the End User during the normal business hours of McTrans for the period for which
the End User pays the subscription fee established by McTrans. McTrans reserves the right to determine the extent
of the support. McTrans reserves the right to make substantial revisions and enhancements to the Software and to
market such substantially revised versions as separate products. End User shall not be entitled to receive such
separate products without additional charge. Upon release of any such revised version of the Software, the
obligation to provide the above-described technical support services to the End User shall cease unless the End
User chooses to pay to license the enhanced version of the Software, whether or not the End User has previously
requested or received support on the prior version.

9. LIMITED WARRANTY AND LIMITATIONS OF REMEDIES: End User agrees that it is the responsibility of End
User to understand fully the limitations of and assumptions underlying the Software and not to make use of the
Software without the assistance of personnel with appropriate expertise. The End User accepts all responsibility for
the program output's review, interpretation, application, and use and accepts all responsibility for ensuring that the
output meets any applicable design code, standard, or project specification provisions.

Except as provided above, the product is provided “AS IS” without warranty of any kind, either expressed or implied,
including, but not limited to, implied warranties of merchantability and fitness for a particular purpose. McTrans does
not warrant that the functions contained in the Software will meet the End User’s requirements or that the operation
of the Software will be uninterrupted or error-free. The entire risk as to the quality and performance of the product
is with the End User. In no event will McTrans be liable to the End User for any damages, including any lost profits,
lost savings, or other incidental or consequential damages arising out of the use of or inability to use the Software,
even if McTrans has been advised of the possibility of such damages, or for any claim by any other party. The
above warranty gives the End User specific legal rights, and the End User may also have other rights in the United
States, which vary from state to state. Use of the Software where the End User believes or has reason to believe
that damage may occur is a violation of any and all warranties. McTrans has no knowledge of the hardware or
Software configurations of the End User and assumes no liability for their damage.

10. TERMINATION: This license is effective from the date the End User receives the Software until this License
Agreement is terminated. End User may terminate it by returning or destroying all copies of the Software and
associated documentation in End User’s possession or control. If the End User breaches any terms of this license,
the license shall terminate immediately.

11. GOVERNING LAW: This License Agreement shall be governed by the laws of the State of Florida, U.S.A. Venue
for all disputes related to this License Agreement shall be in the United States District Court of the Northern District
of Florida, Gainesville Division, or in the Circuit Court of the Eighth Judicial Circuit for Alachua County, Florida.

12. U.S. GOVERNMENT RESTRICTED RIGHTS: The Software and associated documentation are provided with
RESTRICTED RIGHTS. Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set
forth in subdivision (c)(1)(ii) of The Rights in Technical Data and Computer Software clause at 52.227-7013 or
subparagraphs (c)(1) and (2) of the Commercial Computer Software - Restricted Rights at 48CFR52.227-19. The
contractor is McTrans, University of Florida, PO Box 116585, Gainesville, FL 32611-6585.

13. EXPORT REGULATION: The Software may be subject to U.S. export control laws, including the U.S. Export
Control Reform Act and its associated regulations. End User will not directly or indirectly export, re-export, or release
the Software to, or make the Software accessible from, any country, jurisdiction, or person to which export, re-
export, or release is prohibited by applicable law. End User will comply with all applicable laws and complete all
required undertakings (including obtaining any necessary export license or other governmental approval) prior to
exporting, re-exporting, releasing, or otherwise making the Software available outside the U.S.
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14. INTEGRATION: This License Agreement is the complete and exclusive statement of the agreement between
End User and McTrans and supersedes any proposal or prior agreement, oral or written, and any other
communications between End User and McTrans relating to the subject matter of this License Agreement. This
License Agreement may only be modified by a written agreement made subsequent to the date hereof and signed
by both parties.

15. SEVERABILITY: If any portion of this License Agreement shall be declared void or a nullity by a court of
competent jurisdiction, then the remainder shall survive and remain in full force. Should you have any questions
concerning this license, you may contact the McTrans Center, University of Florida, PO Box 116585, Gainesville,
FL 32611-6585, U.S.A., [1] (800) 226-1013.
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Getting Started

System Requirements

HCS is designed for standard Windows installations. For optimal performance, the system should be Windows 10
or newer. While HCS may be compatible with older versions of Windows, any installation and operational issues
arising from using these older versions will be the sole responsibility of the end user.

Getting Started

Freeway Facility Reliability Analysis

Freeway Facility Reliability analyses evaluate the travel time reliability experiences by motorists on an urban or rural
freeway facility. Travel time reliability reflects the distribution of trip travel time over an extended period of time. The
distribution arises from the occurrence of a number of factors that influence travel time (e.g., weather events,
incidents, work zone presence, etc.). The distribution describes how often these factors occur and how bad
operations are as a result. The methodology of the application uses the HCM Chapters 11 and 25 procedures.
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General Controls

Menu Items

New — Creates a new Freeways Reliability file (*.xfr) and starts a new analysis project; shortcut is Ctri+N
Open — Opens an existing Freeways Reliability file (*.xfr); shortcut is Ctrl+O
Example Folder — Opens folder with all HCS examples in File Explorer
Save — Saves an open Freeways Reliability file (*.xfr) using the current file name; shortcut is Ctrl+S
Save As... — Saves an open Freeways Reliability file (*.xfr) using a specified file name; shortcut is F12
Close — Closes an existing Freeways Reliability file (*.xfr); shortcut is Ctrl+W
Units

USC Units — Changes the units of the current file to U.S. Customary

Metric Units — Changes the units of the current file to Metric

Print — Brings up printer selection and prints a Freeways Reliability report to the printer or specified file type; shortcut
is Ctrl+P

Print Preview — Displays preview of current report before printing; shortcut is Ctrl+F2

Report
Formatted Report — Displays formatted report including the most important values; shortcut is F4
Text Report — Displays text report with input, intermediary, and final results; shortcut is F6

Default Settings — Opens a dialog box for the user to input defaults for Analyst, Agency, and Jurisdiction, which
will be applied to all new files; also allows selection of USC or Sl units, which will be applied to all new files; shortcut
is Alt+F

Planning — Opens the Reliability Planning Calculator for the user to input all the necessary information to calculate
results using the planning procedure

Help

Contents — Provides access to glossary, acknowledgements, copyrights, and information on the HCM
procedures; shortcut if Ctrl+F1

Index — Allows user to search keywords within the glossary

Search — Allows user to search for any word within the glossary

User Guide — Opens a comprehensive user guide in PDF format; shortcut is Ctrl+G
HCM Reference Guide — Opens a reference guide for the HCM in PDF format

HCS Updates — Sends the HCS version number anonymously without any personally identifiable
information to McTrans to check for a newer version

HCM/HCS Training — Opens the McTrans Training Page in the default web browser to view the latest
training opportunities
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HCQS Web Page — Opens the TRB Highway Capacity and Quality of Service Committee page in the default
web browser

Support

Frequently Asked Questions — Opens the McTrans support page for HCS in the default web
browser

HCS Overview — Opens the McTrans HCS Overview page in the default web browser
McTrans Website — Opens the McTrans home page in the default web browser

E-mail McTrans — Composes a new e-mail addressed to McTrans in the default e-mail client with
registration number, serial key, module, and version number already populated in the Subject field

About HCS - Opens an about window with software version information, EULA, general
acknowledgements, contact information, and other relevant links

Exit — Exits the HCS Freeways Reliability module; shortcut is Alt+F4
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Freeway Reliability

HCM Chapter 11

The Highway Capacity Software (HCS) faithfully implements the methodology prescribed in the Highway Capacity
Manual (HCM) for analyzing a freeway’s travel time reliability over a multiday or multimonth reliability reporting
period (RRP). The methodology estimates the impacts of recurring and non-recurring congestions (i.e., demand
variations and fluctuations, incidents, weather, work zones, and special events) on the travel time distribution over
the course of the RRP. As an extension, the methodology can be used to estimate the impacts of Active Traffic and
Demand Management (ATDM) strategies on the travel time distribution.

This chapter’s methodology relies on the freeway facilities core methodology presented in Chapter 10, which in turn
applies the freeway segment methodologies in Chapters 12, 13, and 14. The freeway facilities core methodology
focuses the analysis on a single day or less, while the segment methodologies are limited to the analysis of one 15-
min period. In contrast, this chapter's methodology is capable of repeatedly applying the core method across
multiple days, weeks, months, up to a one-year RRP. A one-year RRP is the most common application, although
shorter periods are possible for specific applications (e.g., reliability of summer tourist traffic, a focus on the
construction season). RRPs longer than one year are uncommon, as most typical variations in travel time (day-of-
week, month-of-year, weather, and incidents) are encapsulated in a single year.

STRENGTHS OF THE METHODOLOGY

The methodology is capable of estimating the impacts of non-recurring congestion (due to demand variability,
weather, incidents, work zones, and special events) on the operational performance of a freeway facility over an
extended reliability reporting period—up to one year. Due to the computational efficiency of the HCM freeway facility
core methodology, compared to an analysis of a freeway facility in simulation, for example, a whole-year analysis
can be performed relatively quickly. Specific strengths of the methodology are:

e An efficient method to estimate travel time reliability, which can be applied quickly several hundred times
to derive a travel time distribution over a reliability reporting period up to one year.

o A core methodology that is less computationally intensive than microsimulation.

e A core methodology that can be directly calibrated on the basis of local or regional capacity defaults to
replicate recurring bottlenecks.

e The consideration of local and regional weather defaults for the 101 largest U.S. metropolitan areas based
on a ten-year average.

e A method to estimate incident and crash rates in the absence of detailed local incident logs.

e The ability to extend the method for evaluating ATDM strategies.
In addition, the strength of the core methodology described in HCM Chapter 10 also apply to the reliability and
strategy assessment methods presented here.
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LIMITATIONS OF THE METHODOLOGY

Because the reliability method applies the freeway facility core methodology multiple times, it inherits the core
methodology’s limitations. These limitations were described in HCM Chapter 10. For example, one limitation of the
core method is its use of 15-min analysis periods. Therefore, all event durations (e.g., weather, incidents) used by
the reliability method must be expressed as integer numbers of 15-min analysis periods. The reliability method has
the following additional limitations:

e The method assumes a multiplicative effect when two or more factors (weather and incident) affect speed
or capacity. This assumption has not been sufficiently tested empirically, and may overstate the deleterious
effects of combined non-recurring congestion effects.

o Weather events that have a small effect (<4%) on segment capacity reduction are not addressed. A given
weather event (e.g., rain, snow) is always assumed to occur at its mean duration value. Sun glare is not
accounted for.

e The method assumes that incident occurrence and traffic demand are independent of weather conditions,
although all are indirectly tied to each other through the specification of demand, incident, and weather
probabilities on a calendar basis. However, the analyst is able to adjust incident frequencies by month on
the basis of local data.

e The method estimates incident occurrence as a function of segment demand and month of the year. It does
not consider potentially elevated incident rates in segments with low demands. Some segments may be
overly prone to incidents due to poor visibility, poor geometry, a short weaving segment, or a host of other
factors that are not considered by the reliability method.

e The method does not consider full facility closures in the scenarios. In the course of assigning incidents to
the segments, at least one lane should therefore remain open. The scenario generation methodology does
not assign incidents that result in full-segment closure, but reassigns those probabilities to other (less
severe) incidents. This is also true for work zones, where at least one travel lane has to remain open.

e The travel time reliability analysis assumes similar effects of demand variation and weather conditions on
general purpose and managed lanes, when a managed lane facility is included in the analysis.

o Work-zone events are only allowed to be modeled in general purpose lanes; no managed-lane work zone
effects are considered.

e The traffic-demand adjustment assumes a proportional demand effect across the entire facility, meaning
that all inputs and outputs (across time and space in the base scenario) are increased or decreased by the
same factors.

CALIBRATION AT THE TRAVEL TIME RELIABILITY LEVEL

After calibrating the core freeway facility methodology and fixing the value of its parameters, a comprehensive travel
time reliability calibration is performed. The process includes three major steps: whole-year demand calibration,
incident calibration, and weather calibration.

To calibrate the methodology for a particular site, it is recommended that the analyst perform an initial
comprehensive reliability run using default values for all input parameters and subsequently compare the predicted
travel time index (TTI) cumulative distribution to the observed distribution.

The comprehensive reliability calibration steps include:
e Step 1: Gather input data (demand, weather, incident, distribution, and work zone data
o Step 2: Determine demand multipliers
e Step 3: Calibrate incident probabilities
e Step 4: Calibrate weather probabilities

e Step 5: Validate parameters
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Operational Data
BASE

On the Base page, the user is required to load a base dataset to run a Freeways Reliability analysis. There are two
options when using a base dataset: Load Base Dataset and Create Base Dataset. The program requires the HCS
Freeways module for both these options. The Load Base Dataset button opens a dialog that allows users to open
an existing HCS Freeways (*.xuf) file. The Create Base Dataset button launches the Freeways module where a
user can create a new HCS Freeways (*.xuf) file. If HCS is already installed on the computer, then the Freeways
module should open when this button is clicked. If HCS is not installed, an error will popup and HCS will need to be
installed on the computer to continue with the Freeway Reliability analysis.

The Base page shows a summary of the data from the Freeways file. When a Freeways file is loaded, the required
information from the dataset is extracted for reliability analysis. Two sections appear when the Freeways file is
loaded: Base Dataset Facility and Base Dataset General Information. The number of segments in the facility, along
with the segment type, segment length, and number of lanes on each segment are displayed graphically in the first
section. The second section lists out the Analyst Name, Agency, Jurisdiction, Year, Date, File Name, and Project
Description taken directly from the Freeways file.

ANALYSIS

On the Analysis page, there are fields for the user to specify project properties. These include: Analyst, Agency,
Analysis Year, Jurisdiction, Time Analyzed, Date, and Project Description. The Analysis page is further used to
specify the duration of the reliability reporting period. There are three main sections in the analysis page: Reporting
Period, Study Period, and Number of Replications.

The reliability reporting period represents the specific days over which the travel time distribution it to be computed,
for example, all nonholiday weekdays in a year. The period is specified by start and end dates as well as by the
days of week being considered. The start and end dates can be selected by clicking the calendar in the respective
textbox and selecting the date on the calendar or by typing the date in the format MM/DD/YYYY. The days of week
to be considered in a reliability analysis can be selected by clicking the checkboxes provided for each day of the
week.

If these values are not changed by the user, the following defaults will be used:
e Start Date: Today’s date
o End Date: Today’s date, a year later

o Days of Week: Mon, Tue, Wed, Thu, Fri (all weekdays)
The number of days should be reflected under each month based on the information input for reporting period. The
reliability reporting period is used with the study period to describe the temporal representation of the performance
measure fully (e.g., average travel time on nonholiday weekdays from 4:00 to 6:00 p.m. for the current year).

The Study Period is based on information pulled from the Freeways Base Dataset. Listed in the Study Period box
is the Start Time, End Time, and Duration (min).

The user can specify the number of times the methodology is applied changing the Number of Replications. For a
one-year reliability reporting period, the methodology is typically applied with four replications for each of five
weekdays (Monday through Friday) and 12 months in the year, for a total of 240 scenarios. This approach roughly
corresponds to 250 work days in a typical calendar year. A reliability analysis that includes weekend effects would
result in an increased number of scenarios. For reliability reporting periods that are significantly shorter than one
year, the analyst should increase the number of replications to ensure a sufficient sample size for scenario
generation. The HCM exhibit found below provides guidance on the recommended number of replications in such
cases.
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o e imeeawe ]
Recommended

RRP Duration Number of Days Number of Resulting Number
(months) Considered Replications of Scenarios
1 5 (all weekdays) 43 240
2 5 24 240
4 5 12 240
6 5 g 240
9 5 6 270
12% 5 4% 240*
12 2 (weekend only) 10 240
12 7 (all days)** 3 252

Notes: RRP = reliability reporting period.
*Default value,
**Not desirable; separating weekday and weekend reliability analysis is preferred.

WEATHER

On the Weather page, a drop-down list is located at the top of the screen where a city with available weather data
can be chosen. A city can also be typed into the search bar, which will then match and select the city from the drop
down list.

Once a city is selected, the first table displayed will show the defaults of Weather Event Probability and Weather
Event Duration. The probability of a weather event happening is displayed for each month based on the location
and the study period start time and end time. The default probabilities are based on the Metropolitan Weather
Database for Freeway Reliability Analysis in Volume 4 of the HCM. The duration associated with each weather
even is the length of time of the weather event in minutes. The default duration for each weather event is the same
for each location. If any of the probability defaults or duration is changed, the weather location originally selected
will change to ‘Custom’. To restore the default values, the user can set the location again.

Based on weather conditions and free-flow speeds, the second table displayed shows the Demand Adjustment
Factors, Capacity Adjustment Factors, or Speed Adjustment Factors by switching between the DAF, CAF, and SAF
tabs. Demand Adjustment Factor default values are 1.000 for all. Capacity Adjustment Factor and Speed
Adjustment Factor default values can be found in the tables below.

Default CAFs by Weather Condition:

Capacity Adjustment Factors

55 60 65 70 75
Weather Type Weather Event Definition mifh mi/h mi/h mifh mi/h
Medium rain > (0,10-0.25 in/h 0.94 093 092 091 0.90
Heavy rain > 0.25 in/h 089 088 086 0384 0.82
Light snow >0.00 — 0.05 in/h 0.97 096 096 095 0.95
Light—medium snow >0.05 — 0.10 in/h 095 094 0.92 090 0.88
Medium-heavy snow >0.10 — 0.50 infh 0.93 091 090 (.88 0.87
Heavy snow >0.50 in/h 080 078 076 074 0.72
Severe cold <-4°F 093 092 0.92 091 0.90
Low visibility 0.50 — .99 mi 0.90 090 090 090 0.90
Very low visibility 0.25 — 0.49 mi 0.88 088 0.8 0.88 0.88
Minirmal visibility < (.25 mi 0.90 090 0.90 0.90 0.90
Non—severe weather All conditions not listed above 1.00 100 1.00 100 1.00

Source: Zegeer et al. (I).
Mote:  Speeds given in column heads are free-flow speeds.
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Default SAFs by Weather Condition:

Speed Adjustment Factors
55 60 65 70 75
Weather Type Weather Event Definition mi/h mi/h mi/h mi/h mi/h
Medium rain > 0.10-0.25 in/h 0.9 095 094 093 093
Heavy rain > 0.25 infh 094 093 093 092 091
Light snow >0.00 — 0.05 in/h 0.94 0.92 089 0.87 0.84
Light—medium snow >0.05 - 0.10 infh 092 090 088 086 0.83
Medium—heavy snow >0.10 — 0.50 infh 090 0.88 086 0.84 0.82
Heavy snow >0.50 in/h 0.88 086 085 083 081
Severe cold <-4°F 095 095 094 093 092
Low visibility 0.50 — 0,99 mi 0.96 0.95 094 094 093
Very low visibility 0.25 — 0.49 mi 0.95 0.94 093 092 0091
Minimal visibility < .25 mi 0.95 0.94 093 092 091
Non—severe weather All conditions not listed above 100 100 100 100 1.00

Source: Fegeer et al. ().
Mote: Speeds given in column heads are free-flow speeds.

DEMAND
The Demand page is used to display user inputs related to demand to specify demand ratios.

One of the required inputs is the Freeway Area Type. There are two freeway area types considered: Urban Freeway
and Rural Freeway. The default in the program is Urban Freeway. Once selected, the defaults for Default Freeway
Demand Ratios and Demand Ratios Relative To Base Dataset are displayed. Similar to the table on the Weather
page, the fields in the Default Freeway Demand Ratios table can be edited if necessary. The ratios were derived
from a national freeway dataset developed by SHRP 2 Project L03. All ratios reflect demand relative to a Monday
in January. Where possible, analysts should obtain local or regional estimates of demand variability to account for
facility-specific and seasonal trends on the subject facility.

Default Urban Freeway Demand Ratios (ADT/Mondays in January):

Day of Week
Month Monday Tuesday Wednesday Thursday Friday Saturday Sunday
January 1.00 1.00 1.02 1.05 1.17 1.01 0.89
February 1.03 1.03 1.05 1.08 1.21 1.04 0.92
March 1.12 1.12 1.14 1.18 1.31 1.13 0.99
April 1.19 1.19 1.21 1.25 1.3% 1.20 1.05
May 1.18 1.18 1.21 1.24 1.39 1.20 1.05
June 1.24 1.24 1.27 1:3%1 1.46 1.26 1.10
July 1.38 1.38 1.41 1.45 1.62 1.39 1.22
August 1.26 1.26 1.28 1.32 1.47 1.27 1.12
September 1.29 1.29 1.32 1.36 1.52 1.31 1.15
October $.21 1.21 1.24 1.27 1.42 1.22 1.07
November 1.21 1.21 1.24 1.27 1.42 1.22 1.07
December 1.19 1.19 1.21 1.25 1.40 1.20 1.06

Source: Derived from data presented by Cambridge Systematics et al. (2).
Note:  Ratios represent demand relative to a Monday in January.
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Default Rural Freeway Demand Ratios (ADT/Mondays in January):

Directional No Shoulder 1 Lane 2 Lanes 3 Lanes 4 Lanes
Lanes Incident Closed Closed Closed Closed Closed

2 1.00 0.81 0.70 N/A N/A N/A

3 1.00 0.83 0.74 0.51 N/A N/A

= 1.00 0.85 0.77 0.50 0.50 N/A

5 1.00 0.87 0.81 0.67 0.50 0.50

6 1.00 0.89 0.85 0.75 0.52 0.52

7 1.00 0.91 0.88 0.80 0.63 0.63

8 1.00 0.93 0.89 0.84 0.66 0.66

@O
Source: Zegeer et al. ().

Notes: N/A = not applicable — the number of lanes closed equals or exceeds the number of directional lanes.
The methodology does not permit all directional lanes of a facility to be closed.

The Demand Ratios Relative To Base Dataset table displays the demand ratios relative to the base dataset. The
values in the Default Freeway Demand Ratios table can be edited, if necessary, and the corresponding values in
the Demand Ratios Relative To Base Dataset table will change based on the edited values.

INCIDENT

The Incident page is used to display user inputs related to incident and crash frequency data, distribution and
duration, and adjustment factors based on incident type.

Incidents are generated on the basis of their expected frequency of occurrence per study period (analysis hours in
a day) in a given month on the facility. The analyst may opt to use default expected incident frequencies, may supply
a facility-specific incident or crash rate, or may supply a 12-month table of facility-specific expected frequencies of
any incident type.

The first table displayed on the Incident page is the incident distribution and duration. It provides mean distributions
of freeway incidents by severity and default incident duration parameters by incident type.

Incident Severity Type
Parameter Shoulder 1 Lane 2 Lanes 3 Lanes 44+ Lanes
Closed Closed Closed Closed Closed
Distribution % 75.4% 19.6% 3.1% 1.9% 0%
Duration (Mean) 34 34.6 52.6 67.9 67.9
Duration (Std Dev) 15.1 13.8 i3.9 219 219
Duration (Min) 8.7 16 30.5 36 36
Duration (Max 58 58.2 66.9 093.3 93.3

Source: Zegeer et al. (I).

The second table displayed on the incident page can display either values for Demand Adjustment Factor (DAF),
Capacity Adjustment Factor (CAF), or Speed Adjustment Factor (SAF) by clicking on the corresponding tabs. The
defaults for DAF and SAF are 1.000 for all incident severities. The table below shows the default CAFs associated
with each incident severity. The values shown in the table reflect the remaining relative capacity per open lane. For
example, a two-lane closure incident on a six-lane directional facility (underscored) results in a loss of two full-lane
capacities, in addition to maintaining only 75% of the remaining four open lanes’ capacities. The result is that only
three lanes worth (50%) of the facility’s original six lane capacity is maintained. No information is currently available
on the effect of incidents on free-flow speed, so this effect is not accounted for at this time.
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Directional No Shoulder 1 Lane 2 Lanes 3 Lanes 4 Lanes

Lanes Incident Closed Closed Closed Closed Closed
2 1.00 0.81 0.70 N/A N/A N/A
3 1.00 0.83 0.74 0.51 N/A N/A
4 1.00 0.85 0.77 0.50 0.52 N/A
5] 1.00 0.87 0.81 0.67 0.50 0.50
6 1.00 0.89 0.85 0.75 0.52 0.52
7 1.00 0.91 0.88 0.80 0.63 0.63
3 1.00 0.93 0.89 0.84 0.66 0.66

Source: Zegeer et al. (I).
Motes: MN/A: not applicable, the number of lanes closed equals or exceeds the number of directional lanes.
The methedology does not permit all directional lanes of a facility to be closed.

Incident Frequency Data is also provided, with three choices: Local Incident Frequency, Local Crash Frequency,
and Calculated Crash Frequency. Choosing Local Incident Frequency will enable a table with fields for Incident
Frequency (per 100 million VMT) that by month. Defaults are provided but can be edited if the user is aware of
recurring incident occurrences. If, for example, incidents are more likely in winter months (despite potentially lower
demands), the user should adjust the incident rate defaults and calibrate for local conditions. Choosing Local Crash
Frequency will enable a table with defaults for Crash Frequency (per 100 million VMT) that vary by month. Similar
to Local Incident Frequency, the values are editable for the user to calibrate for local conditions. In addition to this
table, a field is provided for the user to specify the Incident-to-Crash Ratio (ICR). Choosing Calculated Crash
Frequency will cause the Highway Economic Requirements System (HERS) model to be used to calculated crash
rate. Fields for ICR, ACR, and Lane Width will also be provided for the user to specify.

WORK ZONE

The Work Zone page is used to add scheduled work zones to the analysis. The user can add work zone events by
clicking the ‘Add Work Zone Event’ button. If there are already work zone events present in a dataset, the user can
add more by using either the ‘Add Work Zone Event’ button or the ‘Insert Work Zone Event’ button. When the ‘Add
Work Zone Event’ button is used, a new work zone event will be added to the end of the list of work zone events.
When the ‘Insert Work Zone Event’ button is used, a new work zone will be added before the work zone event that
is currently selected in the list of work zone events. To delete work zone events, the user can select one or more
work zone events and then click the ‘Delete Work Zone Event’ button.

When a work zone event is added, the following inputs are provided for the user to change: Segment ID, Start Date,
End Date, Start Analysis Period, Duration Analysis Period, Lane Closure Type, Barrier Type, Area Type, Lateral
Distance, Daylight or Night, Speed Limit, and Percent Drop in Capacity. Segment ID allows the user to specify
which segment in the analysis is affected by a work zone. Start Date and End Date provides the date boundaries
for when the work zone event takes place. Start Analysis Period provides a drop down menu for the user to select
between the analysis periods set from the base dataset. Duration Analysis Period specifies how many analysis
periods the work zone event lasts. Based on the geometry of the facility being analyzed, Lane Closure Type can
have up to five options: Shoulder Closed, 1 Lane Closed, 2 Lanes Closed, 3 Lanes Closed, and 4 Lanes Closed.
Barrier Type has two options: Hard Barrier Separation and Soft Barrier Separation. Area Type also has two options:
urban areas and rural areas. Urban area are typified by high development densities or concentrations of population.
Rural areas are areas with widely scattered development and low housing and employment densities. Lateral
distance is specified in feet and is the distance from the edge of the travel lane adjacent to the work zone to the
barrier, barricades, or cones. Daylight or Night is used to determine whether daytime or nighttime operations are
considered. Speed Limit is used to specify the speed limit, in miles per hour, of the work zone. Higher work zone
speed limits and higher speed ratios result in higher work zone FFS. Percent Drop in Capacity refers to the
percentage drop in pre-breakdown capacity at the work zone due to queuing conditions. Research shows an
average queue discharge drop of 7% in non-work zone conditions, and an average value of 13.4% in freeway work
zones.
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SPECIAL EVENT

The Special Event page is used to add special events, such as football games or concerts, to the analysis. The
user can add special events by clicking the ‘Add Special Event’ button. When the ‘Add Special Event’ button is
used, a new special event will be added to the end of the list of special events. A textbox for ‘Scenario ID for Special
Event’ is provided for the user to enter the appropriate scenario for the special event to be added. To delete special
events, the user can select one or more special events and then click the ‘Delete Special Event’ button.

When a special event is added, a row of the following inputs/information are included: Scenario ID, Analysis Period,
Demand Ratio, Weather Event Count, Incident Event Count, Work Zone Event Count, Import from XUF File, and
Overwritten by Imported File.

EVENTS

The Events page lays out the events found in each of the scenarios generated from the reliability analysis. There
are three tabs to choose what is displayed on the page. These include: Summary, Incident, and Work Zone. The
Summary tab displays the Scenario ID, Analysis Period, Demand Ratio, Weather Event Count, Incident Event
Count, and Work Zone Event Count. The Incident tab displays the Event ID, Incident Event Type, Scenario ID,
Segment ID, Start Analysis Period, and Duration (Analysis Periods). The Work Zone tab displays the Segment ID,
Start Date, End Date, Lane Closure Type, and Assigned Scenarios. All three tabs allows the user to specify how
many items are shown per page by providing a drop-down menu in the upper left-hand corner. The user can specify
10, 20, 50, or 100 items per page to be shown. Navigation buttons are provided below the tables to allow the user
to easily jump between the first, previous, next, or last page of items. All three tabs also provide an ‘Export to CSV’
button in the upper right-hand corner. This will export the entire table of the corresponding tab to a CSV file.

SUMMARY

The Summary page provides a summary of each of the scenarios generated by the reliability analysis. The Scenario
ID, Demand-Combination, Travel Time in minutes, Average Speed in miles per hour, and Average Density in vehicle
per mile per lane are provided for each scenario. Similar to the Events page, a drop-down menu is provided in the
upper left hand corner to allow the user to specify how many items to be displayed per page. Again, the choices for
number of scenarios per page are 10, 20, 50, and 100. Navigation buttons are provided below the table to allow the
user to easily jump between the first, previous, next, or last page of scenarios. There are also three export buttons
provided above the table. These include: Export Summary Results to CSV, Export to XUF, and Export Facility to
CSV. Clicking the ‘Export Summary Results to CSV’ button will allow the user to save the summary results displayed
in the table to be saved in CSV format. ‘Export to XUF’ will allow the user to save all the scenarios generated in the
Freeways XUF format. Clicking this button will open a dialog box allowing the user to browse folders or create a
folder which will save a folder with all the scenarios generated. The folder holding all the scenarios will be titled the
same as the Freeways Reliability XFR file and all the scenarios will be titled Scenario#, with # being the
corresponding scenario number. ‘Export Facility to CSV’ will export the inputs of each scenario into corresponding
CSYV files.

Freeways Reliability Report

The Report page displays the results of the analysis in the form of tables and graphs. There are two reports available
to the user: the formatted report and the text report. The formatted report is initially displayed, but the user can
switch to the text report by clicking the Switch to Text Report button located at the bottom of the screen. Similarly,
if the user has the text report displayed, the Switch to Formatted Report button located at the bottom of the screen
can be used to display the formatted report instead.

The report page shows a formatted version of the analysis in a dynamic form, reacting to changes in the Base,
Analysis, Weather, Demand, Incident, and Work Zone pages. All or a portion can be copied to the Windows
clipboard for insertion into other files by right-clicking into the report and selecting Copy.
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The formatted report provides an overview of the results in the table. There are five sections in the table: Project
Information, Base Dataset Analysis, Reliability Input Summary, Average Performance Measure Results, and graphs
for TTI (TTI Probability Density Distribution and TTI Cumulative Distribution). Project Information provides
information on the Analyst, Agency Jurisdiction, Date, Analysis Year, Time Analyzed, and Project Description. Base
Dataset Analysis provides general information that can be found in the base dataset. These include: the base
dataset file name, the data collection date, the start and end times of the study period, the number of analysis
periods, and the number of segments. Reliability Input Summary provides general information on the reliability
analysis and the random seed summary. These include: Reporting Start Date, Reporting End Date, Reliability
Reporting Period Duration in months, Number of Days Considered, Number of Replications, Number of Scenarios,
what is included in the Reliability analysis (Weather Events, Incident Events, Demand Ratios, and Work Zone
Events) and the random seed numbers for Weather and Incident. Average Performance Measure Results include:
Average Speed in miles per hour, Average Density in passenger cars per mile per lane, Average Travel Time in
minutes, 50" Percentile Travel Time Index (TTlso), Mean Travel Time Index (TTImean), maximum observed facility
TTI (TTImax), Misery Index, Reliability Rating as a percentage, semi-standard deviation, and Percent VMT at TTI >2.
The four graphs at the bottom of the report show the TTI Probability Distribution Function, TTI Cumulative
Distribution Function, Density Distribution, and Speed Distribution.

The text report also provides the general project information and base dataset information but provides more
Average Performance Results. These include: Average Speed in miles per hour, Average Density in both vehicles
per mile per lane and passenger cars per mile per lane, Average Travel Time in minutes, Mean Travel Time Index
(TTlmean), 501 Percentile Travel Time Index (TTlso), 80" Percentile Travel Time Index (TTlso), Planning Time Index
(PTI) or 95" Percentile Travel Time Index (TTlgs), Maximum Observed Facility TTI (TTlmax), Misery Index, Semi-
Standard Deviation, Reliability Rating as a percentage, and Percent VMT at TTI >2.

Both formatted and text reports are available for viewing and printing.
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How To

Create a New File

1. From the Start screen, there are three options for creating a new file:

i"# HCS Freeways Reliability _ - =

]
Start I : r ' Help
New File... ' Topics
Open File... FREEWAYS RELIABILITY HCS Updates
Example Folder... HCS Overview
Recent McTrans Website
HCM/HCS Training
E-mail McTrans
> About HCS
Ya HCS2024 .
Transportation Institute 7_
UF UNIVERSITY of FLORIDA ‘ MC I' anS

Copyright © 2023 University of Florida. All Rights Re HCS™ Freeways Reliability Version 2024

Note: A new file can be created if an existing file is already open; you do not need to start from the Start
screen.
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Selecting File > New from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “New”

"% HCS Freeways Reliability - .6
New N
|
Open Ctrl+0

Example Folder

Save
Save As.. |

m—— orew |
Close s ; Help
Units g y :

| 4 Topics

Print Ctri+P
Print Preview Curl+F2 I ' HES Updates
Report HCS Overview

. FREEWAYS RELIABILITY ;
Default Settings ~ Alt+F McTrans Website
Planning HCM/HCS Training
Help ’ E-mail McTrans
Exit Alc+Fa | About HCS

¥ HCS2024

T tation Instituts P
UF [Giamomeen | MlCTrans y

Copyright © 2023 University of Florida. All Rights Reserved. HCS™ Freeways Reliability Version 2024

Selecting “New File...” from the Start screen; this can be found below in the red box

11 HCS Freeways Reliability B o X

Start | ‘ Help

Open File.. FREEWAYS RELIABILITY HCS Updates
Example Folder... HCS Overview
Recent McTrans Wehsite

HCM/HCS Training

E-mail McTrans

Y2 HCS2024 About HCs
UF b | MICTFANS

Copyright © 2023 University of Florida. All Rights R HCS™ Freeways Reliability Version 2024

Using keyboard shortcut “Ctrl+N”
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2. Once a new file is created, you will be brought to the Base page

{'# FreewaysReliability1.xfr - HCS Freeways Reliability - X

=  START BASE ANALYSIS WEATHER DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT

Please select 3 base dataset.

Load Base Dataset Create Base Dataset

Copyright © 2023 University of Florida. All Rights Reserved. HCS™ Freeways Reliability Version 2024 (USC)

Open an Existing File

1. From the Start screen, there are six options for opening an existing file:

/"% HCS Freeways Reliability . - »

=Eamin
Start I : r ' Help
New File... ! Topics
Open File... FREEWAYS RELIABILITY HCS Updates
Example Folder... HCS Overview
Recent McTrans Website

HCM/HCS Training

E-mail McTrans

% HCS2024 AboutHCS
UF [zt McTrans

Copyright © 2023 University of Florida. All Rights Re¢ HCS™ Freeways Reliability Version 2024

Note: A file can be opened even if another file is currently open; you do not need to start from the Start
screen.
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a. Selecting File > Open from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Open”

"% HCS Freeways Reliability = e
New Ctri+N
[ Open G0 |
Example Folder
Save
Save As..
Close Ctri+W Help
Units » .
4 Topics

Print Cii{+P

i i I ' HCS Updates
Print Preview Ctri+F2

HCS Overview
Report F oo Dvernview
REEWAYS RELIABILITY ;
Default Settings ~ Alt+F McTrans Website
Planning HCM/HCS Trainin
Help E E-mail McTrans
Exit Alt+F4 About HCS
| 1
4 HCS2024
UFlTransporlation Inslillllv:‘ M 1— 7;
vnvensiryoronms. | INIGIT@NS y

Copyright © University of Florida. All Rights Reserved. HCS™ Freeways Reliability Version 2024

b. Selecting “Open File...” from the Start screen; this can be found below in the red box

i’ HCS Freeways Reliability - o X
Start | ‘ Help
New File... J Topics
FREEWAYS RELIABILITY HCS Updates
Example Folder... HCS Overview
Recent McTrans Website

HCM/HCS Training

E-mail McTrans

¥ HCS2024 About HS
UF | tamereraion | MICTr@ns

Copyright © 2023 University of Florida. All Rights R HCS™ Freeways Reliability Version 2024

c. Using the keyboard shortcut “CtrlI+O”

d. Selecting a file under the Recent files list from the Start screen; this can be found below in the red
box
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e.

[ HCS Freeways Reliability = x

Start e ] Help

New File... p I : r' Topics

Open File... : i HCS Updates
Example Folder... HCS Overview
= FREEWAYS RELIABILITY McTrans Website
Facilities7-BaseReliabil... HCM/HCS Training
Facilities8-ReliabilityW... E-mail McTrans
Facilities9-ReliabilityW... About HCS
Facilities10-Reliability...

Y2 HCS2024

T tation Instituts b
UF [viemmeam | MCTFANS j

Copyright © 2023 University of Florida. All Rights Reserved. HCS™ Freeways Reliability Version 2024

Selecting File > Example Folder from the main menu; this can be found by selecting the three lines
in the top left-hand corner of the screen and then selecting “Example Folder”. Opening the example
folder will open the path of the HCS example files in File Explorer. The desired example file can be
double-clicked or right-clicked and selecting ‘Open’, which will open the example file in the
Freeways Reliability program.

/7 HCS Freeways Reliability = ks
New Curl+N
Open Cul+0
| Exampie Folder ]
Save
Save As. F12 |
Close Crl+W
[ ] Help
Units > I Topics
p ! r p
Print Ctri+F
- = ] HCS Updates
Print Preview Cirl+F2 L
Report » HCS Overview
Default Settings ~ Ali+F FREEWAYS RELIABILITY McTrans Website
Planning HCM/HCS Training
Help » E-mail McTrans
Exit Alt+Fd | About HCS

¥4 HCS2024

Ti tation Institut y
UF [t onen | MCTrans

University of Florida. All Rights Reserved. HCS™ Freeways Reliability Version 2024

Selecting “Example Folder...” from the Start screen; this can be found below in the red box.
Opening the example folder will open the path of the HCS example files in File Explorer. The
desired example file can be double-clicked or right-clicked and selecting ‘Open’, which will open
the example file in the Freeways Reliability program.
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HCS Freeways Reliability — m} X

iema
Start ‘_ | ' r ' Help
New File. \ i Topics
Open File... FREEWAYS RELIABILITY HCS Updates
HCS Qverview
Recent McTrans Website

HCM/HCS Training

E-mail McTrans

¥ HCS2024 —
UF | tanrenaton e | MlcTrans

2023 University of Florida. All Rights Rs HCS™ Freeways Reliability Version 2024

2. Once an existing file is opened, you will be brought to the Base page

i Facilities7-BaseReliability.xfr* - HCS Freeways Reliability = X
=  START BASE ANALYSIS WEATHER DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPO
Load Base Dataset Create Base Dataset

Base Dataset Facility

Type Basic Merge Basic Diverge  Basic vieaving  Basic Merge Overlap  Diverge  Basic

Length, ft 5280 1500 2280 1500 5280 2640 5280 1140 360 1140 5280

Segment ID 1 2 3 a H 6 7 8 9 10 1

Lanes 3 3 3 3 3 4 3 3 3 3 3
/N

Base Dataset General

Analyst Agency

Jurisdiction Year 2016

Date 2016  File Name  BaseFile-25-7.xuf
Project Description Chapter 25: Example Problem 1

Copyright © 2023 University of Florida. All Rights Reserved. HCS™ Freeways Reliability Version 2024 (USC)
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Save a File

1. There are five options for saving an open file:

a. Selecting File > Save from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Save”

" FreewaysReliabilityl.xcfr* - HCS Freeways Reliability = X
START BASE ANALYSIS WEATHER DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT
New Ctri+N
Load Base Dataset Create Base Dataset
Open Cirl+Q 2 i 2 b
Examnple Folder et Facility
Save
Save As.. Basic Merge Basic Diverge  Basic Meaving  Basic terge Overlap  Diverge  Basic
ft 5280 1560 2280 1560 5280 2640 5280 1148 368 1148 5280
s b 1 2 3 4 5 5 7 8 9 10 1
Units {2 3 3 3 3 3 4 3 £ 3 3 3
Print

Print Preview

Report b e
Default Settings ~ Alt+F N

Planning 3
Help » Yz
Next

Exit Alt+F4 Base Dataset General

Analyst Agency

Jurisdiction Year 2022

Date 8/31/2022  File Name  Facilities1-Undersaturated.xuf

Project Description Chapter 25: Example Problem 1

23 University of Florida. All Rights Reserved. HCS™ Freeways Reliability Version 2024 (USC)

b. Selecting File > Save As... from the main menu; this can be found by selecting the three lines in
the top left-hand corner of the screen and then selecting “Save As...”

" FreewaysReliabilityl.xcfr* - HCS Freeways Reliability = X
= | START BASE ANALYSIS WEATHER DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT
New Ctrl+
Load Base Dataset Create Base Dataset
Open 2 i = L
Example Folder et Facility
Save
e A | Basic Merge Basic Diverge  Basic Vieaving  Basic Herge Overlap  Diverge  Basic
it s2se 1500 2280 1560 5289 2649 5280 1149 368 1149 5280
it b 1 2 3 4 5 6 7 8 9 10 1
Units 3 3 3 3 3 3 4 3 3 3 3 3
Print

Print Preview

Report v 7N
Default Settings ~ Alt+F / N

Planning

()
Help vl =
Nex

Exit AFd | Base Dataset General

Analyst Agency

Jurisdiction Year 2022

Date 8/31/2022  File Name  Facilities1-Undersaturatedaxuf

Project Description Chapter 25: Example Problem 1

University of Florida. All Rights Reserved. HCS™ Freeways Reliability Versis 4 (USC)

c. Using the keyboard shortcut “Ctrl+S” for Save
d. Using the keyboard shortcut “F12” for Save As
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e. Exiting the program or closing the file without saving changes beforehand; this will prompt you to
save changes to the file before anything is closed

HCS Freeways Reliability X

'jo" Save changes to FreewaysReliability1.xfr?

Yes No Cancel

i. Selecting “Yes” will save the file if it is an existing file. If the file has not been previously
saved, the Save As dialog box will pop up allowing you to change the file name and save
it.

ii. Selecting “No” will exit the program or close the file without saving the file
iii. Selecting “Cancel” will prevent the file from closing

Note: Using Save with an existing file will save a file without prompting you to specify a file name. Using Save with
a new file will bring up the Save As dialog box for you to specify file name for saving. Using Save As will always
bring up the Save As dialog box for you to specify a file name for saving.

Close a File

1. There are three options for closing an open file:

a. Selecting File > Close from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Close”

% Facilities7-BaseReliability.xfr* - HCS Freeways Reliability - X
= START BASE ANALYSIS WEATHER DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT
New Ctri+N
Load Base Dataset Create Base Dataset
Open Ctrl+0
Example Folder et Facility
Save Ctri+S
Save Ass F12 Basic Herge Basic Diverge  Basic Weaving  Basic Merge Overlap  Diverge  Basic
i 1500 2280 1508 5280 2640 5280 1148 360 1149 5280
Glose S, |1 2 3 4 H 6 7 8 9 18 1
Units 3 3 3 3 3 3 4 3 3 3 3 3
Print Ctri+P
Print Preview Ctri+F2
Report r /. N
Default Settings  Alt+F / N
Planning ("
Help vl S
Ne
Exit AltsFd | Base Dataset General
Analyst Agency
Jurisdiction Year 2016
Date 2016 File Name  BaseFile-25-7.xuf
Project Description Chapter 25: Example Problem 1

Copyright © 2023 University of Florida. All Rights Reserved. HCS™ Freeways Reliability Version 2024 (USC)

b. Using the keyboard shortcut “Ctrl+W”

c. Exiting the program itself; please see How To: Exit the Program
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Exit the Program

1. From the Start screen, there are three options for exiting the program:

i'# HCS Freeways Reliability _ o <

Start Help

New File... | ‘ Topics

Open File.. FREEWAYS RELIABILITY HCS Updates
Example Folder... HCS Overview
Recent McTrans Website

HCM/HCS Training

E-mail McTrans

| HC52024 About HCS
UF oo | MlCTFANS

Copyright © 2023 University of Florida. All Rights R« HCS™ Freeways Reliability Version 2024

Note: The program can be exited even if a file is still open; you do not need to start from the Start screen.

a. Selecting File > Exit from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Exit”

[ HCS Freeways Reliability = *

New Ctri+N

|
Open Ctrl+0
Example Folder
Save
Save As.. F12 |
——_— o |
Close W | Help
Units > y 5

| 4 Topics
Print Ctri+P
r!ﬂ 3 = : = I ' HCS Updates
Print Preview, Ctri+F2
Report HCS Overview
S FREEWAYS RELIABILITY T
Planning HCM/HCS Training
Help » E-mail McTrans
Exit Alt+F4 About HCS

Ya HCS2024
Transportation Institute 1— 7)
UF UNIVERSITY of FLORIDA ‘ Mc rans 4

Copyright © University of Florida. All Rights Reserved. HCS™ Freeways Reliability Version 2024

b. Using keyboard shortcut “Alt+F4”
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c. Selecting “X” in the top right-hand corner of the screen; this can be found below in the red box

/7 HCS Freeways Reliahility — m} X
[ ]
Start ‘ | ! r' Help
New File... i Topics
Open File.. FREEWAYS RELIABILITY HCS Updates
Example Folder... HCS Overview
Recent McTrans Website

HCM/HCS Training

E-mail McTrans

2 HCS2024 —
UF | tanrenaton e | MlcTrans

Copyright © 2023 University of Florida. All Rights Re HCS™ Freeways Reliability Version 2024

Edit the Default Settings

1. From the Start screen, there are two options for editing the Default Settings:

'8 HCS Freeways Reliability . - ”

Start W Help

New File... i Topics

Open File... FREEWAYS RELIABILITY HCS Updates

Example Folder... HCS Overview

Recent McTrans Website
HCM/HCS Training
E-mail McTrans

% HCS2024 Aot HCS
UF [visnomoam | MlCTFANS

Copyright © 2023 University of Florida. All Rights Re¢ HCS™ Freeways Reliability Version 2024

Note: The Default Settings can be changed even if an existing file is already open; you do not need to start
from the Start screen.
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a. Selecting File > Default Settings from the main menu; this can be found by selecting the three lines
in the top left-hand corner of the screen and then selecting “Default Settings”

[ HCS Fresways Reliability = X
New Cri+N
Open Ctrl+0
Example Folder
Save
Save As.. F12 |
Close WA
Clos e | Help
Units , 1 pi
i Topics

Print Ctrl+P

= ! HCS Updates
Print Preview, Ctri+F i o Updates
e HCS Overview
o : FREEWAYS RELIABILITY

| Default Settings  Alt+F McTrans Website
Planning HCM/HCS Training
Help » E-mail McTrans
Exit Alt+F4 About HCS
Y2 HCS2024

T tation Instituls
UF | o MCTrans

Copyright © 2023 University of Fiorida. All Rights Reserved. HCS™ Freeways Reliability Version 2024

b. Using the keyboard shortcut “Alt+F”

2. Opening the Default Settings will cause a Default Settings window to pop up:

i Default Settings X

Analyst
Agency
Jurisdiction
New File Default Units
® USC O Metric

oK Cancel

3. You can specify Analyst, Agency, and Jurisdiction by clicking in the corresponding text boxes and typing
the desired text.

4. Under ‘Units’, you are given the option of running the analyses in either U.S. Customary (USC) or SI (Metric)
units.

5. Clicking “OK” will save the changes made and close the Default Settings window; clicking “Cancel” will
close the Default Settings window without saving any changes.

6. When a new file is created, the Analyst, Agency, and Jurisdiction fields will automatically be populated with
the text specified in the Default Settings.

7. When starting a new file, the inputs and results will display according to the units specified in the Default
Settings.
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Load a Base Dataset

1. On the Base page, there are two options to load a base dataset: ‘Load Base Dataset’ and ‘Create Base
Dataset’

7 FreewaysReliability 1xfr - HCS Freeways Reliability _ «

=  START BASE ANALYSIS WEATHER DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT

Please select 3 base dataset,

I Load Base Dataset Create Base Dataset I

Copyright © 2023 University of Florida. All Rights Reserved. HCS™ Freeways Reliability Version 2024 (USC)

a. ‘Load Base Dataset’ will bring up an Open dialog box to allow selection of an existing Freeways
(*.xuf) file

# FreewaysReliabilityxfr - HCS Freeways Reliability

=  START BASE ANALYSIS WEATHER DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT

Please select a base dataset.

Load Base Dataset Create Base Dataset

(&) (>

Bacl 1

Back

University of Florida. All Rights Reserved, HCS™ Freeways Reliability Version 2024 (USC)
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Organize v New folder

Name
sk Quick access
Alternative Intersections

£ Dropbox (UFL) Netutitk
Streets Reliability
# Basici-FourlaneFreeway.cuf
5 This PC {F Basic2-TergetLOSxuf
ff Basic2-TargetLOS-Design.xuf

f Basic3a-SixLaneFreewaysPresentuf

@ OneDrive - University

¥ Network

F Basic3b-SixLaneFreewayFutureuf
# Basic5-MixedFlowauf

< {F Basicé-SevereWeatherxuf
# BasicTa-ManagedLanelxuf

8 BacicTh-Mananac ans? ik
<

~ 4[|« McTrans > HCS2024 > Exemple v

Search Example

Date modified Tpe

File folder
File folder
File folder
XUF File
XUF File
XUF File
XUF File
XUF File
XUF File
XUF File
XUF File
¥IIE File

File name: |

| HeS Freeways files (xuf)

Open Cancel

- @ @

SN ENT EVENTS SUMMARY REPORT

| base dataset,

Create Base Dataset

A~

(uscy

b. ‘Create Base Dataset’ opens the HCS Freeways program allowing you to create a Freeway (*.xuf)
file which can then be saved and loaded into HCS Freeways Reliability using the ‘Load Base

Dataset’ button

# FreewaysReliabilityl.xfr - HCS Freeways Reliability

=  START BASE ANALYSIS WEATHER DEMAND INCIDENT WORKZONE SPECIAL EVENT EVENTS SUMMARY REPORT

Please selec,

Load Base Dataset

base dataset,

Create Base Dataset

HCS™ Freeways Reliability Version
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=  START BASE ANALYSIS WEATHER DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT

Please se

base dataset.

Start p r Help
New File... 1 Topics

Open File... FREEWAYS HCS Updates
Example Folder... HCS Overview
Recent McTrans Website

HCM/HCS Training

E-mail McTrans

¥Z HCS2024 Abour HES
UF Gt |INICTF@NS

University of Flor i Freeways Vers

niversity of Florida. All Rights : HCS™ Freeways Rel

Load Regional Weather

1. On the Weather page, a weather location can be selected if you choose not to use the HCM defaults.
{"# FreewaysReliability1.xfr* - HCS Freeways Reliability - Xe
= START BASE AN. S WEATHER DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT

Please select 3 Weather Location

HCM Default o

Current Location: HCM Default

Medium rain 0.80 0.80 1.01 1.01 1.01 0.71 0.71 0.71 0.86 0.86 0.86 0.80 402
Heavy rain 0.47 0.47 0.81 0.81 0.81 133 133 133 0.68 0.68 0.68 0.47 33.7:
| Lightsnow 0.91 0.91 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.91 93.1

| Light-mediumsnow | 029 | 029 | 000 | 000 | 000 | 000 | 000 | 000 | 000 | 000 | 000 | 029 | 334
Medium-heavysnow| 004 | 004 | 000 | 000 | 000 | 000 | 000 | 000 | 000 | 000 | 000 | 004 | 217

_Heavy snow 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 73
N\ Severe cold 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.0 S~
(@ Low visibility 097 0.97 0.12 0.12 0.12 0.16 0.16 0.16 0.34 0.34 0.34 0.97 762 ( %)
\
= Very low visibility 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.0 N
et Minimal visibility | 044 | 044 | 0.0 010 0.10 0.00 0.00 0.00 003 0.03 0.03 044 | 1450 Next
Non-severe weather  96.09 96.09 97.95 97.95 97.95 97.80 97.80 97.80 98.08 98.08 98.08 96.09 999.0
’ 55 mi/h 60 mi/h 65 mi/h 70 mi/h 75 mi/h
Medium rain 1.000 1.000 1.000 1.000 1.000
Heavy rain 1.000 1.000 1.000 1.000 1.000
Light snow 1.000 1.000 1.000 1.000 1.000
| Light-medium snow 1.000 1.000 1.000 1.000 1.000
Medium-heavy snow 1.000 1.000 1.000 1.000 1.000
Heavy snow 1.000 1.000 1.000 1.000 1.000
Severe cold 1.000 1.000 1.000 1.000 1.000 -
Copyright © 2023 University of Florida. All Rights Reserved. HCS™ Freeways Reliability Versiol
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2. Adrop down list of U.S. cities is provided. You can open the list by selecting the down arrow and scrolling
through to search for a particular city or you can type a city in the box which will find the location in the list.

{7 FreewaysReliabilitylxfr* - HCS Freeways Reliability = X
= START BASE ANALYSIS WEATHER DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT
Please select 2 Weather Location =
HCM Default =
HCM Default -
Akron, OH l
[| Albany, NY
Albuguerque, NM Apr May Jun Jul Aug Sep Oct Nov Dec | Durati
Allentown, PA
Atlanta, GA 1.01 1.01 0.71 0.71 0.71 0.86 0.86 0.86 0.30 40.2
Biienicin, GA 81 0.81 333 1.33 133 0.68 0.68 0.68 0.47 337
st T 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.91 93.1
i .00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.29 334
skersfield, CA
= 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.04 21.7
sltimore, MD
.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 73
Baton Rouge, LA
H 0.00 0.00 0.00 0.00 0.00 0.00 Q.00 Q.00 0.00 0.0
Birmingharm, AL
” ~10.12 012 018 0.16 0.16 0.34 034 0.34 0.97 76.2
@ewiow visibility | 0.00 000 000 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.0
Minimal ility | 0.44 044 0.10 0.10 010 0.00 0.00 0.00 0.03 0.03 0.03 0.44 145.0
Non-severe weather | 96.09 96.09 97.95 97.95 97.95 97.80 97.80 97.80 98.08 95.08 95.08 96.09 999.0

SAF
60 mi/h 65 mi/h 70 mi/h 75 mi/h
Medium rain 1.000 1.000 1.000 1.000
Heavy rain_ | 1.000 1.000 1.000 1.000 1.000
Lightsnow 1.000 1.000 1.000 1.000 1.000

A LS
Medium-heavy snow
avy snow |

Severe cold

Copyright © 2023 University of Florida. All Rights Reserved. HCS™ Freeways Reliability Version 2024 (USC)

3. Once a city is selected, it will automatically populate the table with the corresponding values.

[ FreewaysReliabilityl.ucfr* - HCS Freeways Reliability =

=  START BASE ANALYSIS WEATHER DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT

Orlando, FL A

Current Location: Orlando, FL

’ Jan Feb Mar Apr May Jun Jul Aug Sep Oct Nov Dec  |Duration

Mediumrain | 035 0.40 0.70 0.05 0.30 035 0.05 025 020 070 030 025 40.2
"Heavy rain 1.20 0.40 075 030 050 010 0.25 0.20 0.40 050 015 070 337
Light snow 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 93.1
Light-medium snow |__0.00 0.00 0.00 0.00 000 | 000 0.00 0.00 0.00 0.00 0.00 0.00 334

Medium-heavysnow| 000 | 000 | 000 | 000 | o000 | o000 | o000 | o0oo | ooo | ooo | oo | ooo | 217
000 | 000 | 000 | 000 | 000 | 000 | 000 | 000 | 000 | 000 | 000 | 000 73

000 | 000 | 000 0.00 0.00 0.00 000 | 000 | 000 | 000 | 000 | 000 0.0

Low visibility | 275 125 | 050 | 050 | 020 | 060 035 010 | 050 | 055 | 125 230 | 762
Very low visibility | 000 | 0.00 0.00 0.00 0.00 0.00 000 | 000 | 000 | o0oo | 000 | 000 0.0
Minimal visibility | 4.40 535 1.50 055 0.20 0.00 0.50 0.05 035 065 145 230 | 1450

Non-severe weather | 91.30 92.50 96.55 98.20 98.80 98.95 98.90 99.35 98.55 97.60 96.90 94.45 999.0

SAF
60 mi/h 65 mi/h 70 mi/h 75 mi/h
Medium rain 1.000 1.000 1.000 1.000
Heavy rain_ 1.000 1.000 1.000 1.000 1.000
Light snow 1.000 1.000 1.000 1.000 1.000

Light-mecium snow
Medium-heavy snow

Copyright © 2023 University of Florida. Al Rights Reserved. HCS™ Freeways Reliability Version 2024 (USC)
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The table is editable so individual cells can be changed if necessary. If a value is changed, the Current
Location will change to Custom.

# FreewaysReliabilityl xf* - HCS Freeways Reliability _ g

=  START BASE ANALYSIS WE. R DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT

Custom -

Current Location: Custom
..

Jan Feb Mar Apr May | Jun Jul Aug Sep Oct Nov Dec |Duration
Medium rain 035 0.40 0.70 0.05 0.30 0.35 0.05 025 0.20 0.70 030 025 40.2
Heavy rain 1.20 0.40 075 030 0.50 0.10 0.25 0.20 040 0.50 0.15 0.70 337
_Light snow 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0,00 0.00 93.1
light-medium snow 0.0 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 334
Medium—heavy snow 0.0 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 21.7
 Heawy snow 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 7.3
Severa cold 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 00
( Low visibility 275 125 050 050 0.20 0.60 035 010 050 055 125 230 76.2 )
Very low visibility | 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 00
‘Minimal visibility | 4.40 5335 1.50 035 020 0.00 0.50 0.05 035 065 145 230 | 1450 Nex
Non-severe weather 9130 | 9260 | 9655 | 9820 | 9880 | 9895 | 9885 | 9940 | 9855 | 97.50 | 9685 | 9445 | 5990

55 mi/h 60 mi/h 65 mi/h 70 mi/h 75 mi/h
Medium rain 1.000 1.000 1.000 1.000 1.000
Heawyrain | 1.000 1.000 1.000 1.000 1.000
Light snow 1.000 1.000 1.000 1.000 1.000
_Light-medium snow | 1.000 1.000 1.000 1.000 1.000
Medium-heavy snow 1.000 1.000 1.000 1.000 1.000
i I 1.000 1.000 1.000 1.000 1.000,
1.000 1.000 1.000 1.000 1.000 .

University of Florida. All Rights Reserved. HCS™ Freeways Rell

View Results of the Analysis

1.

After editing all the necessary inputs and generating scenarios, results of the analysis can be found in the
form of tables on the Events and Summary pages, and in the form of reports on the Report page.

i Facilities7-BaseReliability xfr* - HCS Freeways Reliability - X
=  START BASE ANALYSIS WEATHER DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT

[ summary | inctom | vorkzone |

Scenarios per page: 20 ~ Export to CSV
‘Snmaﬁnln Analysis Period |Demand Ratio | Weather Event Count| Incident Event Count | Work Zone Event Count

1 Jan-Mon 0.826 a 1 0
2 Jan-Mon 0.826 a 0 0
3 Jan-Mon 0.826 Q 2 0
4 Jan-Mon 0.826 a o 0
5 Jan-Tue 0.826 1 2 0
6 Jan-Tue 0.826 a 0 0

g 7 Jan-Tue 0.826 Q 1 0

(<) 8 Jan-Tue 0.826 0 1 0 > )

9 Jan-Wed 0.843 Q 1 1] =
10 Jan-Wed 0.843 Q 1 0 Nex
k| Jan-Wed 0.843 a 0 0
12 Jan-Wed 0.843 Qo o 0
13 Jan-Thu 0.868 [4] 1 0
14 Jan-Thu 0.865 [} 1 o
15 Jan-Thu 0.868 4] 0 4]
16 Jan-Thu 0.868 1 1 0
17 Jan-Fri 0.970 (4] 0 0
18 Jan-Fri 0.970 a ] 0
19 Jan-Fri 0.970 Q 1 1]
20 Jan-Fri 0.970 a ] 0

20 of 240 Mext > | Last>>

University of Florida. All Rights Reserved. HCS™ Freeways Rell
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acilities7-BaseReliability.xfr* - HCS Freeways Reliability

=  START BASE ANALYSIS WEATHER DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT

Back

@ Scenarios Details
Scenarios per page: 20 ¥

Export Summary Results to CSV

Export to XUF

Export TTl in TPs to CSV

Scenario ID Demand Combination |  Travel Time (min) | Average Speed (mi/h) I";"'"”'”""""""
1 Jan-Mon 6.20 58.1 18.7
2 Jan-Mon 6.20 58.1 18.7
3 Jan-Mon 6.20 58.1 18.7
4 Jan-Mon 6.20 58.1 18.7
5 Jan-Tue 6.30 57.1 19.1
6 Jan-Tue 6.20 58.1 187
7 Jan-Tue 6.20 58.1 18.7
8 Jan-Tue 6.20 57.7 18.9
9 Jan-Wed 6.20 58.1 191
10 Jan-Wed 6.20 58.1 19.1
1" Jan-Wed 6.20 58.1 19.1
12 Jan-Wed 6.20 58.1 19.1
13 Jan-Thu 6.20 58.0 19.7
14 Jan-Thu 6.20 58.0 19.7
15 Jan-Thu 6.20 58.0 19.7
16 Jan-Thu 8.50 425 27.2
17 Jan-Fri 6.30 57.5 222
18 Jan-Fri 6.20 57.7 222
19 Jan-Fri 6.20 577 222
20 Jan-Fri 6.20 ST 222

20 of 240 Next > Last >>

Next

Copyright © 2023 University of Florida. All Rights Reserved. HCS™ Freeways Reliability Version 2024 (USC)

Back

acilities7-BaseReliability:xfr® - HCS Freeways Reliability
= START BASE ANALYSIS WEATHER DEMAND INCIDE!

HCS Freeway Reli

WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT

ty Report

Project Information

Analyst Dats 8/31/2022

Agency Analysis Year 2022

Jurisdiction Time Analyzed

Project Description Chapter 25: Example Units US. Custornary
Problem 7

Base Dataset Analysis

Base Dataset File Name BaseFile-25-Txuf Data Collection Date 11/1/2016

Start Time 07:00 End Time 10:00

MNumber of Analysis Periods 12 Number of Segments "

Reliability Input Summary

Reporting Start Date 2/1472017 Reporting Start Date 2/14/2018

RRP Duration; months 12 Number of Days Considered 262

Number of Replications 4 Mumber of Scenarios 240

Include Westher Event Yes Include Incident Event Yes

Weather Seed Number 1 Incident Seed Number 1

Include Demand Ratio Yes Include Wark Zone Yes

Average Performance Measure Results

Average Speed, mi/h 525 Average Density, pc/mifin 262

Average Travel Time, min T.08 50th Percentile Travel Time Index (TTIs0) | 1.03

80th Percentile Travel Time Index (TTlzo) | 1.08 Planning Time Index (TTlos) 177

Mean Percentile TT| (TTImean) 1.08 Level of Travel Time Reliability (LOTTR) 1.05

University of Florida. All Rigl
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2. There are two options for reports: Formatted and Text

a. Formatted reports show the most important results in presentable format.

HCS Freeway Reliability Report

T Probability Distribution

T Distriution

T Cur Distiibution

Density Distribution

[ 5 16
Toave! Tin s 1T

b. Text reports show the results in plain text.

File Name:

Analyst:

Agency:
Jurisdiction:

Date:

Analysis Year:

Time Analyzed:
Project Description:
Units:

HCS Freeways Reliability Text Report

Facilities7-BaseReliability.xfr

8/31/2022
2022

Chapter 25: Example Problem 7
U.5. Customary

BRI REERE R
Oty fondnided

Speed Distribution

3. The type of report displayed can be changed by using the main menu items, keyboard shortcuts, or toggle

Base Free-Flow Speed, mi/h 60.2
Base Free-Flow Travel Time, h 6.83
Number of Segments 11
Number of Analysis Periods 12
Start Time 87:00
End Time 18:00
Reliability Reporting Period (RRP), months 12
Number of Scenarios 249

Average Performance Results

Average Speed, mi/h

Average Density, veh/mi/ln

Average Density, pc/mi/ln

Average Travel Time, min

Mean Percentile Travel Time Index (TTImean)
5@th Percentile Travel Time Index (TTIS@)
8@th Percentile Travel Time Index (TTI8@)
Level of Travel Time Reliability (LOTTR)
Planning Time Index (TTI95)

Maximum Observed Facility TTI (TTImax)
Misery Index

Semi-standard Deviation

Standard Deviation

Reliability Rating, %

Percent WMT at TTI»>2, %

52.5
26.2
26.8
7.86
1.21
1.03
1.88
1.85
1.77
32.97
3.68
1.16
1.14
88.9
2.81

This Freeways Travel Time Reliability text report was created in HCS™ Freeways Reliability Version 2024 on 10/24/2023 14:23:22

buttons found under the report

a.

Main Menu ltems

i. To switch to the Formatted Report, select File > Report > Formatted Report from the main
menu; this can be found by selecting the three lines in the top left-hand corner of the

screen, hovering over “Report”, and then selecting “Formatted Report”.

34-
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Facilities7-BaseReliability.xfr* - HCS Freeways Reliability = X

— START BASE ANALYSIS WEATHER DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT

New Crl+n B
Open 0
i HCS Freeway Reliability Report
Example Folder
Save Crri+s
2
= o Date #/31/2022
Analysis Year 2022
Close et -
Time Anslyzed
Units ,
Chapter 25: Exomple Units US. Customary
Peing | Problem 7
Print Preview is
Report » ” | Formatted Report _ F4. Data Collection Date 11/1/2016
6 End Ti 10:00
Default Settings | [TextReport i i
| |2 Number of Segments 1
Planning !
nmary
Help »
211472017 Reporting Start Date 211472018
Ent SITEEE 2 Number of Days Considered 262
Number of Replications 4 Number of Scenarios 230
Include Weather Event Yes Include Incident Event Yes
Weather Seed Number 1 Incident Seed Number 1
Include Demand Ratio Yes Include Work Zone Yes
Average Performance Measure Results
Average Speed, mith 525 Average Density, pe/min 262
Average Travel Time, min 706 S0th Percentile Travel Time Index (TTIs0) | 1.03
80th Percentile Travel Time Index (TTi20) 108 Planning Time Index (TTles) 177
Mean Percentile TTI (TTimean) 108 Level of Travel Time Reliabilfty (LOTTR] | 1.05

University of Florida. All

ii. To switch to the Text Report, select File > Report > Text Report from the main menu; this
can be found by selecting the three lines in the top left-hand corner of the screen, hovering
over “Report”, and then selecting “Text Report”.

i1 Facilties7-BaseReliability xfr* - HCS Freeways Reliability - X
= | START BASE ANALYSIS WEATHER DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT
New Cri+N -

HCS Freeways Reliability Text Report
Open Cul+0
Example Folder

Facilities7-BaseReliability.xfr

Save Ctri+S
Save As... F12
ot 5/31/2022
Close c e
Hpits s Chapter 25: Example Problem 7
ot G U.S. Customary
Print Preview Crri+F2
Report »| |Formatted Report _Fa | £52
Default Settings  A+F | [ Text Report = e
e
07:08

Planning s

» fiod (RRP), months 12
Help 240

Exit Alt+F4

Aversge Performance Results,
Average Speed, mi/h 52.5

b.

C.

Average Density, ven/mi/ln 26.2
Average Density, pe/misln 26.8
Average Travel Time, min 7.06
Mean Percentile Travel Time Index (TTInean) 121
56th Percentile Travel Time Index (TTISE) 1.03
86th Percentile Travel Time Index (TTIse) 1.08
Level of Travel Time Reliability (LOTTR) 1.85
Planning Tine Index (TTI3S) 1.77
Maxinum Observed Facility TTI (TTImax) 32.97
Misery Index 3.60
Semi-standard Deviation 1.16
Standard Deviation 114
Reliability Rating, % 5.9
Percent \MT at TTI>2, % 2.81

Keyboard Shortcuts

i. Formatted Report: keyboard shortcut is “F4”

ii. Text Report: keyboard shortcut is “F6”

Report Toggle Buttons

i. Atoggle button is available at the bottom of the screen underneath the report.

Freeways Reliability User Guide
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If the formatted report is currently being displayed, the toggle button will say “Switch to Text
Report” which will allow you to display the text report if clicked.

i1 Facilities7-BaseReliability.xfr* - HCS Freeways Reliability

Project Information

Analyst Date 8/31/2022
Agency Analysis Year 2022
Jurisdiction Time Analyzed
Project Description Chapter 25: Example Units US. Customary
Problem 7

Base Dataset Analysis
Base Dataset File Name BaseFile-25-7xuf Data Collection Date 11/1/2016
Start Time 07:00 End Time 1000

7o Number of Analysis Periods 12 Number of Segments 1

(\f—,) iability Input Summary

Back Reporting Start Date 21472017 Reporting Start Date /1472018
RRP Duration, months 12 Number of Days Considered 262
Number of Replications 4 Number of Scenarios 240
Include Weather Event Yes Include Incident Event Yes
Weather Seed Number 1 Incident Seed Number 1
Include Demand Ratio Yes Include Work Zone Yes
Average Performance Measure Results
Average Speed, mi/h 52.5 Average Density, pe/mi/in 262
Average Travel Time, min 7.06 50th Dercentile Travel Time Index (TTIso) [ 103
80th Percentile Travel Time Index (TTiao) | 108 Planning Time Index (TTigs) 177
Mean Percentile T (TTimesr) 108 Level of Travel Time Reliability (LOTTR) | 105

3

Switd] Report

- x

=  START BASE ANALYSIS WEATHER DEMAND INCIDEI WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT
HCS Freeway Reliability Repol

If the text report is currently being displayed, the toggle button will say “Switch to Formatted
Report” which will allow you to display the formatted report if clicked.

{1 Facilities-BaseReliability.xf* - HCS Freeways Reliability

sl x
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Chapter 25: Example Problem 7
U.S. Customary

Base Free-Flou Speed, mi/h 60.0
Base Free-Flou Travel Time, h 6.00
lumber of Segments 1
Number of Analysis Periods 12
Start Time 87:88
End Time 1e8:08
Reliability Reporting Period (RRP), months 12
Number of Scenarios 249

Average Speed, mi/h

Average Performance Results
52.5

Average Density, veh/mi/ln 26.2
Average Density, pc/mi/ln 26.8
Average Travel Time, min 7.86
Mean Percentile Travel Time Index (TTImean) 121
58th Percentile Travel Time Index (TTIS@) 1.3
8oth Percentile Travel Time Index (TTIs2) 1.08
Level of Travel Time Reliability (LOTTR) 1.85
Planning Time Index (TTI35) 1.77
Maximum Observed Facility TTI (TTImax) 32.97
Misery Index 3.60
Semi-standard Deviation 1.16
Standard Deviation 1.14
Reliability Rating, % 38.9
Percent VIT at TTI>2, % 2.81
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4. The magnification of the report currently being displayed can be changed using the zoom slider found at
the bottom right-hand corner of the screen.

7 FacilitiesT-BaseReliabilityaxfr* - HCS Freeways Reliability - X

=  START BASE ANALYSIS WEATHER DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT
HCS Freeway Reliability Report

Project Information

Analyst Date 8/31/2022

Agency Analysis Year 2022

Jurisdiction Time Analyzed

Project Description Chapter 25: Example Units USS. Custornary
Problem 7

Base Dataset Analysis

Base Dataset File Name BaseFile-25-Txuf Data Collection Date 11/1/2016
Start Time 07:00 End Time 10:00

N Number of Analysis Periods 12 Number of Segments "

(\’:— ) Reliability Input Summary

Back Reporting Start Date 2714/2017 Reporting Start Date 2/14/2018

RRP Duration, months. 12 Number of Days Considered 262
Number of Replications 4 MNumber of Scenarios 240
Include Weather Event Yes Include Incident Event Yes
Weather Seed Number 1 Incident Seed Number 1
Include Demand Ratio Yes Include Work Zone Yes

Average Performance Measure Results

Average Speed, mi/h 525 Average Density, pe/mifin 262
Average Travel Time, min 7.06 50th Percentile Travel Time Index (TTI50) 1.03
80th Percentile Travel Time Index (TTiz) | 108 Planning Time Index (TTios) 177

Mean Percentile TT| (TTlmean) 108 Level of Travel Time Reliability (LOTTR) 105

'3 University of Florida. All Rights Reserved.

a. Tozoom in, drag the slider to the right; to zoom out, drag the slider to the left
b. Clicking the plus (+) button will zoom in; clicking the minus (-) button will zoom out

c. Holding down “ctrl” on the keyboard and scrolling up on the mouse wheel will zoom in; holding
down “ctrl” on the keyboard and scrolling down on the mouse wheel will zoom out

Print a Report

1. There are four options for printing a report:

a. Selecting File > Print from the main menu; this can be found by selecting the three lines in the top
left-hand corner of the screen and then selecting “Print”

i Facilities7-BaseReliability.xfr* - HCS Freeways Reliability = e
START BASE ANALYSIS WEATHER DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT

New Ctri+N =
Open Ctrl+0 T
R HCS Freeway Reliability Report
Example Folder
Save Crl+S
B F Date 8/31/2022
Analysis Year 2022
Close Ctri+W
Time Analyzed
,
s Chapter 25: Example. Units US. Customary
Print Cul+P || Erbisii
Print Preview Cui+F2 s
Report ; BaseFile-25-Touf Data Collection Date 11/1/2016
07:00 End Ti 10:00
Default Settings ~ Alt+F | il
§ 12 Number of Segments 11
Planning ;
nmary
Help g
211472017 Reporting Start Date 2/14/2018

et kiR 12 Number of Days Considered 262

Number of Replications 4 Mumber of Scenarios 240

Include Weather Event Yes Include Incident Event Yes

Weather Seed Number 1 Incident Seed Number 1

Include Demand Ratio Yes Include Work Zone Yes

Average Performance Measure Results

Average Speed, mi/h 525 Average Density, pe/miln 262

Average Travel Time, min 7.06 50th Percentile Travel Time Index (TTisg) | 103

80th Percentile Travel Time Index (TTizo) | 108 Planning Time Index (TTiss) 177

Mean Percentile TT1 (TTImsan} 108 Level of Travel Time Relability (LOTTR)

University of Florida. All Rights Reserved.
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b. Selecting File > Print Preview from the main menu; this can be found by selecting the three lines in
the top left-hand corner of the screen and then selecting “Print Preview”

1% Facilties7-BaseReliabilityxfr - HCS Fresways Reliability = X
= START BASE ANALYSIS WEATHER DEMAND INCIDENT WORK ZONE SPECIAL EVENT EVENTS SUMMARY REPORT
New ctl+N | =
Open Curl+0 S
‘ HCS Freeway Reliability Report
Example Folder
Save culss |
e i [ Date 8/31/2022
[ Analysis Year 2022
Close ClsW |
Time Analyzed
Units ,
Chapter 25: Example Units Us. Customary
Print CrisP Ard i
Print Preview Cul+F2  [lis
Eeral 5 BaseFile-25-Tauf Data Collection Date 11/1/2016
Default Settings ~ Alt+F | e ERCINE Eo00)
. 12 Number of Segments 11
Planning -
nmary
Help .
| 211472017 Reporting Start Dat= 21412018
Fiot e | 12 Number of Days Considered 262
Number of Replications 4 Number of Scenarios 240
Include Weather Event Yes Include Incident Event Yes
Weather Seed Number 1 Incident Seed Number 1
Include Demand Ratio Yes Include Work Zone Yes

Average Performance Measure Results

Average Speed, mifh 525 Average Density, pe/mifln 262
Average Travel Time, min 706 50th Percentile Travel Time Index (TTiso) | 1.03
80th Percentile Travel Time Index (TTizo) [ 1.08 Planning Time Index (TTisz) 177

Mean Percentile TT| (TTImean) 108 Level of Travel Time Reliability (LOTTR) 1.05

University of Florida. All Rights Reserved. HCS™ Freeways Reliability Version 2024 (USC)

c. Using keyboard shortcut “Ctrl+P” for Print
d. Using keyboard shortcut “Ctrl+F2” for Print Preview
2. Print

a. Using Print will bring up a Print dialog box where you can select which printer to print to
= Print X

General I
~ Select Printer

7® Microsoft Print to PDF
™ Microsoft XPS Document Writer
™ OneNote for Windows 10

< >
Status: Ready Preferences |
Location:

~Page Range
« Al Number of copies: |1 E
o fior ¢ Cor

11/ 22/ 33
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3. Print Preview

a. Using Print Preview will bring up a window where you can view how the report will look on paper

before sending

1 Print

it to the printer

W

Project Information

HCS Freeway Reliability Report

| Type text to find.. v

b. The print icon in the toolbar found in the top left-hand corner can then be selected

6 ]

A

c. A print dialog box will pop up where you can select which printer to print to

o —
= A e

lg!l Print

General |

X

— Select Printer

7® Microsoft

<

Status:
Location:

Print to PDF

™ Microsoft XPS Document Writer
= OneNote for Windows 10

Ready Preferences |

Analyst Date 8/31/2022
Agency Analysis Year 2022
Jurisdiction Time Analyzed
Project Description Chapter 25: Example Units U5, Customary
Problem 7

Base Dataset Analysis
Base Dataset File Name Basefile-25-7xuf Data Collection Date 11/1/2016
Start Time 07:00 End Time 1000
Number of Analysis Periods. 12 Number of Segments n
Reliability Input Summary
Reporting Start Date 2/14/2017 Reporting Start Date 21472018
RRP Duration, months 12 Number of Days Considered 262
Number of Replications 4 Number of Scenarios 240
Include Weather Event Yes Include Incident Event Yes.
Weather Seed Number 1 Incident Seed Nurber 1
Include Demand Ratio Yes Include Work Zone Yes.

ge Per Results
Average Speed, mi/h 525 Average Density, pc/mifin 262
Average Travel Time, min 7.06 50th Percentile Travel Time Index (TTIs0) | 1.03
80th Percentile Travel Time Index (TTisg) | 108 Planning Time Index (TT1o5) 177
Mean Percentile TTI (TTimean) 1.08 Level of Travel Time Reliability (LOTTR) 105
Misery Index 360 Reliability Rating, % 889
Semi-Standard Devistion 116 Percent VMIT 2t TTI >2 % 281
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Glossary of Terms

50" Percentile Travel Time Index (TTlso)

TTlso describes the median of the TTI distribution. This can be a useful measure and is less influenced by outliers
than the mean.

80" Percentile Travel Time Index (TTlso)

This measure has been found to be more sensitive to operational changes than the TTlgs, which makes it useful for
strategy comparison and prioritization purposes. In the exhibit found below, the 80" percentile travel time is
approximately 36 minutes, thus the 80" percentile TTl is 36/15 = 2.4,
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Freeway Facility Travel Time (min)

Cumulative Distribution Function (CDF)

—e— Cumulative Distribution Function (CDF)
—Probability Density Function (PDF)

95t Percentile Travel Time Index (TTlos)

The 95" Percentile TTl is also referred to as the planning time index (PTI) and is a useful measure for estimating
the added time travelers must budget to ensure an on-time arrival with “failure” limited to one trip per month. In the
exhibit found below, the 95" percentile travel time is 45 min, compared to a free-flow travel time of 15 min; thus,
TTlss = 3.0. The planning time is the difference between the 95™ percentile and free-flow travel times, or 30 min.
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The facility AADT divided by its two-way hourly capacity; this value is used in the computation of CR, which is the
crash rate per 100 million VMT (or 161 million VKkmT in metric).

See also Highway Economic Requirements System (HERS).

Agency

This field is provided to document the agency or company associated with this analysis or project.

Analysis Period

The time interval evaluated by a single application of an HCM methodology (15 min for the freeway facility core
methodology). In the exhibit found below, there are 12 such analysis period for the facility, represented by the rows
in the rectangles. Each cell in a rectangle represents a single analysis period for a single analysis segment.

xd
Each cell is one " @'6\\\\0{‘
analysis period of @G\‘ zo"
Temporal an analysis segment. o

Dimension

EOERNARE R RN

19:00 =L = = = = : el
R s 4: 31 3 Reliability
Study : [ s 2 .
Period z : 3: Reporting Period
16:00 I —— Spatial

Dimension

Facility
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Analysis Segment

An HCM freeway segment (e.g., basic, merge, diverge, weaving) as described in Chapters 12 through 14. Each
column in the exhibit found below represents an analysis segment.

xd
Each cell is one " 66‘\".\00
analysis period of Q&\ e;&\"
Temporal an analysis segment. oV

Dimension

.......
.......
-------

A TETER

Reliability
Study i _
Period Reporting Period
Spatial
Dimension

Facility

Analysis Year

This field is provided to document the year for which the analysis is being performed.

Analyst

This field is provided to document the name of the analyst.

Area Type

There are two area types: urban areas and rural areas. Urban areas are typified by high development densities or
concentrations of population. Rural areas are areas with widely scattered development and low housing and
employment densities.

Barrier Type

There are two barrier types: concrete and hard barrier separation; and cone, plastic drum, or other soft barrier
separation.

Base Dataset

The base dataset provides all the required input data for the freeway facilities core methodology described in HCM
Chapter 10. Some data are specific to the freeway facility being studied. These include, at a minimum, all segment
geometries (both general purpose and managed lanes, if applicable), free-flow speed, lane patterns, and segment
type, along with base demands that are typically, but not necessarily, reflective of average (AADT) conditions. In
addition, the base dataset contains the required input data to execute HCM Chapter 11’s reliability methodology.
These data include a demand multiplier matrix, weather, work zones, and incident events as described later in this
section. The majority of the reliability-specific input data can be defaulted when they are not available locally, but
the analyst is encouraged to supply facility-specific data whenever feasible.

The user has the option to load a base dataset or create a base dataset. Clicking on ‘Load Base Dataset’ will open
a dialog box to allow the user to select a Freeways Facility (*.xuf) file for the user to open and load into the Freeways
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Reliability program. Once loaded, a facility graphic of the base dataset will be displayed on the page, along with
general information. Clicking on ‘Create Base Dataset’ will open the HCS Freeways program to allow the user to
create a new base dataset for use in the Freeways Reliability program.

Base Dataset Date

This specifies the date of the base dataset. A base scenario is always required and is used to describe base
conditions (particularly demand and factors influencing capacity and free-flow speed). The base scenario is intended
to represent average demand conditions (e.g., annual average daily traffic, AADT), or the demand measured on a
specific day. HCM Chapter 11’s methods factor these demands on the basis of user-supplied or defaulted demand
patterns to generate demands representative of all other analysis periods during the reliability reporting period.

Base Scenario (Seed File)

A set of parameters representing the facility’s calibrated operating conditions during one study period. All other
scenarios are developed by adjusting the base scenario’s inputs to reflect the effects of varying demand, weather,
incidents, work zones, or a combination of these that occur in other study periods. When the methodology is
executed using a computational engine, the base scenario’s parameters become inputs to the seed file used by the
engine.

Capacity Adjustment Factor (CAF)

Factor used to allow the user to adjust the capacity for reduced-capacity situations or to match field measurements.
The capacity in any cell of the time-space domain can be reduced to represent incident situations such as
construction and maintenance activities, adverse weather, traffic accidents, and vehicle breakdowns. Similarly,
capacity can be increased to match field measurements.

Cumulative Density Function (CDF)

The CDF gives the number of percent of all observations at or below a specified travel time bin. The exhibit found
below illustrates two types of distributions, with the PDF shown by the solid line and the CDF by the dashed line.
The facility travel times shown on the x-axis represent the midpoints of the various travel bins. See also Probability
Density Function (PDF).
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Date

This field is provided to document the date when the analysis is performed.
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Daylight or Night

This is used to determine whether daytime or nighttime operations are considered.

Demand Adjustment Factor (DAF)

Factor used to allow the user to adjust the demand for the purpose of calibration, or to reflect the impacts of weather,

incidents, and work zones.

Demand Ratios

The exhibits found below present default demand ratios by day of week and month of year for urban and rural
freeway facilities. The ratios were derived from a national freeway dataset developed by SHRP 2 Project L03. All
ratios reflect demand relative to a Monday in January. Where possible, analysts should obtain local or regional
estimates of demand variability to account for facility-specific and seasonal trends on the subject facility.

Default Urban Freeway Demand Ratios (ADT/Mondays in January):

Day of Week
Month Monday Tuesday Wednesday Thursday Friday Saturday Sunday
January 1.00 1.00 1.02 1.05 147 1.01 0.89
February 1.03 1.03 1.05 1.08 121 1.04 0.92
March 1.12 1,12 1.14 1.18 1.31 1.13 0.99
April 1.19 1.19 1.21 1,25 1.39 1.20 1.05
May 1.18 1.18 1.21 1.24 1.39 1.20 1.05
June 1.24 1.24 1.27 $:31: 1.46 1.26 1.10
July 1.38 1.38 1.41 1.45 1.62 1.39 1.22
August 1.26 1.26 1.28 1.32 1.47 1.27 1.12
September 1.29 1.29 1.32 1.36 1.52 1.3t 1.15
October 1.21 1.21 1.24 1.27 1.42 1.22 1.07
November 1.21 1.21 1.24 127 1.42 1.22 1.07
December 1.19 1.19 1.21 1.25 1.40 1.20 1.06

Source: Derived from data presented by Cambridge Systematics et al. (2).

Note:

Default Rural Freeway Demand Ratios (ADT/Mondays in January):

Ratios represent demand relative to a Monday in January.

Day of Week
Month Monday Tuesday Wednesday Thursday Friday Saturday Sunday
January 1.00 0.96 0.98 1.03 1.22 1.11 1.06
February 111 1.06 1.09 1.14 1.35 1.23 1.18
March 1.24 1.19 1.21 1.28 1.51 1.37 1.32
April 1.33 1.27 1.30 1.37 1.62 1.47 1.41
May 1.46 1.39 1.42 1.50 1.78 1.61 1.55
June 1.48 1.42 1.45 1.53 1.81 1.63 1.57
July 1.66 1.59 1.63 1.72 2.03 1.84 1.77
August 1.52 1.46 1.49 1.57 1.86 1.68 1.62
September 1.46 1.39 1.42 1.50 1.78 1.61 1.55
October 1.33 1.28 131 1.38 1.63 1.47 1.42
November 1.30 1.25 1.28 1.35 1.59 1.44 1.39
December 147 1:42 1.14 1.20 1.43 1.29 1.24

Source: Derived from data presented by Cambridge Systematics et al. (2).

Note:

These default demand ratios are displayed in the first table of the Demand page depending on the Freeway Area
Type selected. The second table of the Demand page displays the demand ratios relative to the base dataset. The
values in the first table can be edited by the user, if necessary, and the corresponding values in the second table

will change based on the edited values.

Ratios represent demand relative to a Monday in January.
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Export Buttons

Export buttons are provided on the Events page and Summary page.

On the Events page, Export to CSV is provided under each tab for the user to export the table results into a CSV
file. For example, if the user wants to export the Incident data, a dialog box will appear after clicking ‘Export to CSV’
under the Incident tab. The user can specify a name for the CSV file or keep the default name. After saving the file,
all incident events from all pages will be saved in CSV format.

On the Summary page, three export buttons are provided. These include: Export Summary Results to CSV, Export
to XUF, and Export Facility to CSV. ‘Export Summary Results to CSV’ is similar to the export buttons on the Events
page. Clicking this button will allow the user to save the summary results displayed in the table to be saved in CSV
format. ‘Export to XUF’ will allow the user to save all the scenarios generated in the Freeways XUF format. Clicking
this button will open a dialog box allowing the user to browse folders or create a folder which will save a folder with
all the scenarios generated. The folder holding all the scenarios will be titled the same as the Freeways Reliability
XFR file and all the scenarios will be titled Scenario#, with # being the corresponding scenario number. ‘Export
Facility to CSV’ will export the inputs of each scenario into corresponding CSV files.

Facility Evaluation

In the facility evaluation step, each scenario is analyzed using the freeway facilities core methodology. The
performance measures of interest to the evaluation—in particular, facility travel time—are calculated for each
analysis period in each scenario and stored. At the end of this process, a travel time distribution is formed from the
travel time results stored for each scenario.

Failure or On-Time Measures

The percentage of analysis time periods with space mean speeds above (on time) or below (failure) one or more
target values (e.g., 35, 45, and 50 mi/h). These measures address how often trips succeed or fail in achieving a
desired travel time or speed.

Free-Flow Speed

1. The average speed of vehicles on a given segment, measured under low-volume conditions, when drivers
are free to drive at their desired speed and are not constrained by the presence of other vehicles or
downstream traffic control devices.

2. The theoretical speed when both density and flow rate are zero.

Units: USC
The adjusted free-flow speed is determined by the HCM equation found below.
FFS = BFFS — fiyw — fric — 3.22x TRDO-84

where
FFS = free-flow speed of the basic freeway segment (mi/h),
BFFS = base FFS for the basic freeway segment (mi/h),
fiw = adjustment for lane width (mi/h),
fric = adjustment for right-side lateral clearance (mi/h), and
TRD = total ramp density (ramps/mi).

If a field measured free-flow speed is entered, no subsequent adjustments are made and the adjusted free-flow
speed will simply be the field-measured free-flow speed. Freeway Merge, Diverge, and Weaving segments require
direct speed measurements, estimated from design speed or speed limit.
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Units: Metric
Free-Flow Speed is measured in km/h. Calculations are done in USC but converted to metric.

Highway Economic Requirements System (HERS)

When the crash rate is not available locally, the Highway Economic Requirements System (HERS) model can be
used to estimate it. The crash or incident rate is estimated per 100 million VMT (or per 161 million VkmT in
metric). The HERS models uses the following equation to estimate crash rate:

CR = (154.0 — 1.203 X ACR + 0.258 X ACR? — 0.00000524 X ACR®) x 0-0082x(12-LW)

where CR is the crash rate per 100 million VMT (or per 161 million VkmT in metric), ACR is the facility AADT divided
by its two-way hourly capacity, and LW is the lane width in feet (or meters in metric).

Import from XUF File

Clicking this will allow the user to choose a file to override the default event creation.

Incident Distribution and Duration

The duration of each incident severity type is assumed to follow a lognormal distribution. The default parameters
for the incident duration distribution was developed through research. The defaults for freeway incident severity
distribution and duration parameters, in minutes, are provided below:

Incident Severity Type
Parameter Shoulder 1 Lane 2 Lanes 3 Lanes 4+ Lanes
Closed Closed Closed Closed Closed
Distribution % 75.4% 19.6% 3.1% 1.9% 0%
Duration (Mean) 34 34.6 53.6 67.9 67.9
Duration (Std Dev) 15.1 13.8 i3.9 21.9 21.9
Duration (Min) B.7 16 30.5 36 36
Duration (Max 58 58.2 66.9 93.3 93.3

Source: Zegeer et al. (1).

Incident Frequency Data

Radio button choices are provided for specifying the type of Incident Frequency Data. These choices include: Local
Incident Frequency, Local Crash Frequency, and Calculated Crash Frequency.

Selecting Local Incident Frequency will provide a table with defaults for Incident Frequency (per 100 million VMT in
USC or per 161 million VkmT in metric) that vary by month. The values are editable for the user to calibrate for local
conditions.

Selecting Local Crash Frequency will provide a table with defaults for Crash Frequency (per 100 million VMT in
USC or per 161 million VkmT in metric) that vary by month. The values are editable for the user to calibrate for local
conditions. In addition to this table, a field is provided for the user to specify the Incident-to-Crash Ratio (ICR).

Selecting Calculated Crash Frequency will cause the Highway Economic Requirements System (HERS) model to
be used to calculate crash rate. Fields for ICR, ACR, and Lane Width will also be provided for the user to specify.

Incident-to-Crash Ratio (ICR)

ICR is the local incident-to-crash ratio. In the absence of other data, a national default value for ICR is 4.9.
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Items per page

A drop down menu is provided for the user to specify the scenarios or events to be displayed per page.

Jurisdiction

This field is provided to document any jurisdiction convention or project related information.

Lane Closure Type
Lane Closure Type expresses how many lanes are closed in the work zone.

The lane closure configuration in a work zone is expressed as the ratio of the number of original lanes to the number
of lanes present in the work zone. For instance, a 3-to-1 lane closure configuration means that three lanes are
normally available, but that two lanes were closed during construction and only one lane was open. Research shows
that this ratio is effective in showing influences of different lane configurations on speed or capacity.

Lane Width

The lateral distance, in feet (or meters in metric), between stripes for a given lane

Lateral Distance

The distance, in feet (or meters in metric), from the edge of travel lane adjacent to the work zone to the barrier,
barricades, or cones.

Level of Travel Time Reliability (LOTTR)

Level of travel time reliability, or LOTTR, is the measure of the 80t percentile travel time index (TTlso) divided by
the 50t percentile travel time index (TTlso):

LOTTR = TTlso / TTlso

Local Crash Frequency

Fields are provided for Crash Frequency (per 100 million VMT in USC or per 161 million VKkmT in metric) if the
analyst is aware of recurring crash occurrences that vary by month. If, for example, crashes are more likely in winter
months (despite potentially lower demands), the analyst should adjust the crash rate defaults and calibrate for local
conditions.

Local Incident Frequency

Fields are provided for Incident Frequency (per 100 million VMT in USC or per 161 million VkmT in metric) if the
analyst is aware of recurring incident occurrences that vary by month. If, for example, incidents are more likely in
winter months (despite potentially lower demands), the analyst should adjust the incident rate defaults and calibrate
for local conditions.

Location

Rainfall, snow, temperature, and visibility weather data were collected for several different cities. Defaults are
provided by month for each of the cities listed in the drop down menu on the Weather page. If a city is not listed
and the analyst has local data available, the fields in the table can be edited and the Current Location will become
‘Custom’.

Freeways Reliability User Guide Glossary of Terms - 47



Mean Travel Time Index (TTlmean)

TTlmean describes the mean of the TTI distribution. This can be a useful measure and more influenced by outliers
than the median.

Misery Index

A measure comparing the average of the worst 5% of travel times to the free-flow travel time.

Navigation Buttons

On the Events page and Summary page, there are four buttons that can be found at the bottom of the table being
displayed. These buttons include: << First, < Previous, Next >, and Last >>. When there are several scenarios or
events in an analysis that are displayed in multiple pages, the user can use the buttons to navigate between pages.
The ‘<< First’ button will display the first page, the ‘< Previous’ button will display one page back, the ‘Next >’ will
display one page forward, and the ‘Last >>’ button will display the last page. If all scenarios or events can be
displayed on one page, then all four buttons will be disabled.

Number of Lanes

This specifies the number of lanes on the freeway in the analysis direction. If there is a weaving segment, the
number of auxiliary lanes is also included. When there is a managed lane, the number of lanes is the number of
general purpose lanes.

Number of Replications
This number ensures a sufficient sample size for scenario generation.

For a one-year RRP, the methodology is typically applied with four replication for each of five weekdays (Monday
through Friday) and 12 months in the year, for a total of 240 scenarios. This approach roughly corresponds to 250
work days in a typical calendar year. A reliability analysis that includes weekend effects would result in an increased
number of scenarios.

For RRPs that are significantly shorter than one year, the analyst should increase the number of replications to
ensure a sufficient sample size for scenario generation. The exhibit below provides guidance on the recommended
number of replications in such cases.

Recommended
RRP Duration Number of Days Number of Resulting Number
(months) Considered Replications of Scenarios
1 5 (all weekdays) 48 240
2 5 24 240
- 5 12 240
6 5 8 240
9 5 6 270
12* 5 4% 240*
12 2 (weekend only) 10 240
12 7 (all days)** 3 252

Notes: RRP = reliability reporting period.
*Default value.
¥*Not desirable; separating weekday and weekend reliability analysis is preferred.
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Peak Hour Speed

The speed expected on the freeway during the peak hour, in miles per hour (or kilometers per hour in metric).

Percent Drop in Capacity

Percent Drop in Capacity refers to the percentage drop in pre-breakdown capacity at the work zone due to queuing
conditions. Research shows an average queue discharge drop of 7% in non-work zone conditions, and an average
value of 13.4% in freeway work zones.

Percentile Travel Time Index (TTlpp)

Represents the pp percentile TTI in the travel time distribution. For example, TTlss means that this observation is
exceeded only 15% of the time in the travel time distribution. Common TTI percentiles are TTlso (the median TTI)
and TTlgs (the 951 percentile TTI). When pp is omitted, the value often represents the mean TTI for the distribution,
which in HCM chapter 11 is referred to as T Tlmean.

Performance Summary

In the final step, travel time reliability is described for the entire RRP. The travel time distribution is used to quantify
a range of variability and reliability metrics.

Planning Time Index (PTI)

See 95" Percentile Travel Time Index (TTlgs).

Probability Density Function (PDF)

The PDF gives the number or percent of all observations within a specified travel time (or TTI) bin. The exhibit found
below illustrates two types of distributions, with the PDF shown by the solid line and the CDF by the dashed line.
The facility travel times shown on the x-axis represent the midpoints of the various travel bins. See also Cumulative
Density Function (CDF).
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Project Description

This field is provided for the user to document the analysis with any information for identification purposes.
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Random Number Seed

A random number seed is used with the Monte Carlo methods in the reliability methodology. A seed is used so that
the sequence of random events can be reproduced. Unique seed numbers are separately established for weather
events and incidents. For a given set of two seed numbers, a unique combination of demand levels, weather events,
incidents, and work zones is estimated for each analysis period in the reliability reporting period.

Reliability Rating

The percentage of vehicle miles traveled (or vehicle kilometers traveled in metric) on the freeway facility that
experiences a TTl less than 1.33. This threshold approximates the points beyond which travel times become much
more variable (unreliable).

Reliability Reporting Period (RRP)

The specific set of days over which travel time reliability is computed; for example, all non-holiday weekdays in a
year. The RRP represents the third dimension that extends the freeway facility core methodology and is illustrated
in the exhibit found below by the series of rectangles (scenarios).
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The Start Date indicates the beginning date of the RRP, the End Date indicates the final date of the RRP, and the
days checked off indicate which days of the week are considered within the timeframe of the RRP.

The RRP can be as long as one calendar year, although shorter periods are also possible. A one-year RRP is most
typical, as it encompasses all day-to-day, and month-to-month variability in demand, as well as all weather and
incident effects. However, shorter RRPs can be used to focus on reliability during specific analysis periods. The
minimum recommended RRP is one month to capture sufficient variability in demand and other factors.

Reset to Default Ratios

The ‘Reset to Default Ratios’ button is provided to undo changes to cells within the Default Freeways Demand
Ratios table made by the user. If this button is clicked, all cells within the table will revert back to the default values.

Scenario

A single instance of a study period for the facility, having a unique combination of traffic demands, capacities,
geometries, and free-flow speeds represented in its analysis periods. Each rectangle in the exhibit found below
represents a unique scenario, or in other words one day of the year.
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Scenario Generation

The process of enumerating the various combinations of factors including demand, weather, incidents, and
scheduled work zones, and calculating their probability of occurrence is termed freeway scenario generation.

The scenario generator develops a set of scenarios reflecting conditions that the freeway facility may experience
during the reliability reporting period. Each scenario represents a single study period (typically several hours long)
that is fully characterized in terms of demand and capacity variations in time and space. The data supplied to the
scenario generator are expressed as multiplicative factors (CAFs, SAFs, and demand adjustment factors [DAFs])
or additive factors (humber of lanes) that are applied to the base free-flow speed, demand, capacity, and number
of lanes.

The scenario generation process includes the following steps:

e Adjusting the base demand to reflect day-of-week and month-of-year variation associated with a given
scenario;

¢ Generating inclement weather events on the basis of their local probability of occurrence in a given time of
year and adjusting capacities and free-flow speeds to reflect the effects of the weather events;

e Generating various types of incidents on the basis of their probability of occurrence and adjusting capacities
to reflect their effects; and

e Incorporating analyst-supplied information about when and where work zones and special events occur,
along with any corresponding changes to the base demand or geometry.

The results from these steps are used to develop one scenario for each study period in the reliability reporting
period.

The Scenario Generation Settings allow the user to indicate whether or not to include Demand, Weather, Incident,
and/or Work Zone in scenario generation.

Scenario ID

Scenarios generated from the reliability analysis are numbered in a natural order (1, 2, 3, etc.). The scenario IDs
are numbered starting with the earliest demand combination (i.e., Jan-Mon comes before Jan-Tue).

Scenario ID for Special Event

This is provided for the user to enter the appropriate scenario for the special event to be added.
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Scenario Name

This is provided for the user to enter a name that describes the corresponding special event.

Segment ID

The segments of a facility are numbered in a natural order (1, 2, 3, etc.). The segment ID number refers to the
number of the segment found in the Base Dataset Facility graphic.

Semi-Standard Deviation

A one-sided standard deviation, with the reference point being free-flow travel time (or TTI=1) instead of the mean.
It reflects the mean variability from free-flow conditions.

Special Event Buttons

On the Special Event page, the user can add and delete special events to be included in the reliability analysis. The
“Add Special Event” button allows the user to add a special event for the preselected scenario. The “Delete Special
Event” button allows the user to delete one or multiple special events at a time. The user must select the special
event(s) to be deleted before clicking the button.

Special Events

Special events are short-term events, such as major sporting events, concerts, and festivals that produce intense
traffic demands on a facility for limited periods. Special traffic control procedures may need to be implemented to
accommodate the traffic demands. The analyst should identify whether any events that occur in or near the study
area warrant special treatment. If so, a schedule for the event (dates, starting times, typical duration) should be
obtained. Some types of events also have varying intensities that will require separate treatment (e.g., a sold-out
baseball game compared with a lower-attendance midweek game). Recurring events may have developed special
traffic control procedures; if so, these plans should be consulted to identify any changes required from base
conditions. Each combination of special event venue and event intensity to be included in the analysis will need to
be specified.

Speed Adjustment Factor (SAF)

Factor used to allow the user to adjust speed based on a combination of different sources, including weather and
work zone effects. The SAF may also be used to calibrate the estimated FFS for local conditions or other effects
that contribute to a reduction in FFS. For example, poor pavement conditions or sun glare may result in drivers
reducing their speeds even under low-volume conditions.

Study Period

The time interval within a day for which facility performance is evaluated. It consists of one or more consecutive
analysis periods, represented by the rows in the rectangles in the exhibit found below. In this example, the study
period is 3 h long, running from 4 p.m. to 7 p.m. (i.e., 16:00 to 19:00 hours).
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Time Analyzed

This field is provided to document the time frame of the analysis as morning peak, afternoon peak, existing
conditions, future projections, etc.

Traffic Demand

The methodology accounts for demand variability by adjusting the traffic demands for the analysis periods included
in the various scenarios. This is done through the use of a demand multiplier, which is the ratio of the daily (weekday-
month combination) facility demand to the average daily traffic (or to any combination of day of week and month of
year). A second adjustment is needed to factor the demand measured on the specific day-month combination in
the base scenario to any other day-month combination in the year. Traffic demand variation for different hours of
the day is already accounted for in the base scenario obtained from the HCM Chapter 10 core facility analysis.

For example, if the base scenario demand data were gathered on a Monday in January that has a demand multiplier
of 0.85, and a demand scenario is being tested on a Friday in June that has a demand multiplier of 1.10, then the
base scenario demands should be factored by a ratio of 1.10/0.85 = 1.29 to create the demand profile for that
Friday-in-June scenario. When considering all days of the week, there could be up to 84 demand combinations; for
weekday-only analyses, there could be up to 60 demand combinations.

Traffic Incidents

Incidents are generated on the basis of their expected frequency of occurrence per study period (analysis hours in
a day), in a given month on the facility. The analyst may opt to use default expected incident frequencies, may
supply a facility-specific incident or crash rate, or may supply a 12-month table of facility specific expected
frequencies of any incident type. The incident frequency represents the average number of all incidents experienced
on the facility during the study period, and is allowed to vary in each month.

The method makes the following assumptions about a given incident:

e The incident start time is assigned stochastically to any analysis period, which is done automatically by the
computational engine;

e The incident duration is assigned stochastically, on the basis of the severity-defined incident duration
distribution;

e The incident location is assigned stochastically, weighted by the individual segment vehicle miles traveled
(VMT) or vehicle kilometers traveled (VkmT); and

e The incident severity is assigned stochastically, on the basis of the distribution of incident severity.

Default adjustment factors for incidents are provided in Section 5 of HCM Chapter 11.
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Travel Time

The time required for a vehicle to travel the full length of the freeway facility from mainline entry point to mainline
exit point without leaving the facility or stopping for reasons unrelated to traffic conditions

Travel Time Distribution

The distribution of average facility travel times by analysis period across the reliability reporting period. Each 15-
min analysis period within each scenario contributes one data point to the travel time distribution. It is not the
distribution of individual vehicle travel times (or TTIs).

The travel time distribution and some of its key performance measures are illustrated in the exhibit found below.
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Travel Time Index (TTI)

The ratio of the actual travel time to the free-flow travel time. By definition, TTI is always = 1.0. The TTI has an
identical distribution to travel time, except that its values are indexed to the free-flow travel time.

Volume-to-Capacity (v/c) Ratio

The ratio of flow rate to capacity for a system element

Weather Event Duration

The duration associated with each weather event is the length of time of the weather event in minutes. The default
duration for each weather event is the same for each location. If a duration is changed, the weather location
originally selected will change to ‘Custom’. To revert back to the default values, the user can set the location again.

Weather Event Probability

The probability of a weather event happening is displayed for each month based on the location and the study
period start time and end time. The default probabilities are based on the Metropolitan Weather Database for
Freeway Reliability Analysis in Volume 4 of the HCM. If any of the probability defaults are changed, the weather
location originally selected will change to ‘Custom’. To revert back to the default values, the user can set the location
again.
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Weather Events

Weather events are generated on the basis of their probability of occurrence during a given month. The scenario
generation process accounts for ten categories of severe weather events that have been shown to reduce capacity
by at least 4%, along with a non-severe weather category that encompasses all other weather conditions and that
generates no capacity, demand, or speed adjustments. Default capacity and speed adjustment factors for weather
events are provided in Section 5 of HCM Chapter 11.

To capture the actual occurrences of various weather events, the analyst may use default weather data from any
of 101 U.S. metropolitan areas, based on 2001-2010 weather records. These values are documented in HCM
Chapter 25, Freeway Facilities: Supplemental.

Alternatively, the analyst may supply a 12-month by 11-weather-event matrix (132 total values) of local probabilities
of each weather event, along with the average duration for each event (10 values). As mentioned earlier, different
weather events are assigned stochastically to the various scenarios in a manner that will match their monthly
occurrence based on the site’s meteorological data.

Weather Type

There are different types of weather conditions. The HCM categorizes weather into 11 different types. These
include: Medium rain, Heavy rain, Light snow, Light-medium snow, Medium-heavy snow, Severe cold, Low visibility,
Very low visibility, Minimal visibility, and Non-severe weather.

The tables below provide default CAFs and SAFs by weather type and facility free-flow speed. Note that the changes
in CAFs and SAFs for decreasing visibility shown in the exhibit may be counterintuitive, since they are based on a
single site.

The SAF is applied to the base free-flow speed, and CAF is applied to the base capacity, both of which are
calculated in the respective methodological chapters for the various freeway segment types. Both may also have
been adjusted in the process of calibrating the core facility in Chapter 10 of the HCM. The adjustment factors below
should be applied in addition to any prior CAF and SAF calibration.

Default CAFs by Weather Type:

Capacity Adjustment Factors

55 60 65 70 75
Weather Type Weather Event Definition mi/h mi/h mi/h mi/h mi/h
Medium rain > 0.10-0.25 in/h 094 093 092 0.1 0.9
Heavy rain > 0.25 in/h 0.89 0.88 0.8 0.84 0.82
Light snow >0.00 - 0.05 in/h 097 096 09 0.95 0.95
Light—-medium snow >0.05 -0.10 in/h 095 054 092 0.0 0.88
Medium-heavy snow >0.10 - 0.50 in/h 093 091 0.90 0.88 0.87
Heavy snow >0.50 in/h 0.80 0.78 0.76 0.74 0.72
Severe cold <-4°F 093 0.92 092 0.91 0.9
Low visibility 0.50 — 0.99 mi 090 0.0 090 0.90 0.9
Very low visibility 0.25 — 0.49 mi 0.88 0.88 0.88 0.88 0.88
Minimal visibility < 0.25 mi 090 0950 0590 0.0 0.9
Non—severe weather All conditions not listed above 1.00 1.00 1.00 1.00 1.00

Source: Zegeer et al. (7).
Note: Speeds given in column heads are free-flow speeds.
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Default SAFs by Weather Type:

Speed Adjustment Factors
55 60 65 70 75
Weather Type Weather Event Definition mi/h mi/h mi/h mi/h mi/h
Medium rain > 0.10-0.25 in/h 09 0595 094 0593 0.93
Heavy rain > 0.25 in/h 094 093 093 0.92 0.91
Light snow >0.00 - 0.05 in/h 094 0052 0.8 0.87 0.84
Light-medium snow >0.05 - 0.10 in/h 092 050 0.88 0.86 0.83
Medium-heavy snow >0.10 - 0.50 in/h 0.0 0.88 0.86 0.84 0.82
Heavy snow >0.50 in/h 0.88 0.86 0.85 0.83 0.81
Severe cold <-4°F 095 0.5 094 0.93 0.92
Low visibility 0.50 — 0.99 mi 096 095 094 094 0.93
Very low visibility 0.25 — 0.49 mi 095 054 093 0592 0.91
Minimal visibility < 0.25 mi 095 094 093 092 0.91
Non—severe weather All conditions not listed above 1.00 1.00 1.00 1.00 1.00

Source: Zegeer et al. (7).
Note:  Speeds given in column heads are free-flow speeds.

Work Zone

A work zone is a segment of highway in which maintenance or construction operations reduce the number of lanes
available to traffic or affect the operational characteristics of traffic flowing through the segment.

This portion of the analysis pertains exclusively to scheduled, significant work zone events. Minor patching and
repair activities are not treated as work zones, but these important activities can be treated as incident events in
the procedure and may be added to the incident tally. As such, a work zone constitutes any activity that results in
scheduled closures of the shoulder or one or more travel lanes. Typically, a work zone lasts multiple days or weeks.
In some cases, it involves multiple stages, each with different shoulder- and lane-closure parameters.

The details of scheduled work-zone activities must be entered by the analyst and cannot be defaulted. A work-zone
log should be entered in which the following information is input for each work-zone activity that is planned during
the RRP:

e Calendar days of the start and end dates of the work-zone activity;
e Facility segment(s) and analysis periods impacted by the work-zone activity;

e Portions of the facility cross-section impacted by closures (i.e., shoulder, one-lane, or multiple-lane
closures);

o Type of barrier used to separate traffic from the work activity (i.e., concrete or other hard barrier, or cones,
drums, or other soft barrier);

e Regulatory speed limit in effect during the work zone activity; and
e Lateral separation between traffic and the work zone.

The methodology can accommodate multiple work-zone activities, each with its own sets of inputs. CAFs and SAFs
for work zones have been developed by national research and are described in Section 4 of HCM Chapter 10,
Freeway Facilities Core Methodology.

Work Zone Buttons

On the Work Zone page, the user can add, insert, or delete work zone events to be included in the reliability analysis.
The ‘Work Zone Event +’ button allows the user to add work zone events. An unlimited number of work zone events
can be added. The ‘Insert Work Zone Event’ button allows the user to insert a work zone event in between existing
work zone events. The user must select a work zone event to insert a new work zone event before it. The ‘Work
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Zone Event - button allows the user to delete one or multiple work zone events at a time. The user must select the
work zone event(s) to be deleted before clicking the button.

Work Zone Duration Analysis Period

This number specifies how many analysis periods the work zone event lasts.

Work Zone End Date

This is the date the work zone event finishes.

Work Zone Speed Limit

The work zone speed limit is the speed limit, in miles per hour (or kilometers per hour in metric), of the work zone.
Higher work zone speed limits and higher speed ratios result in higher work zone FFS.

Work Zone Start Date

This is the date the work zone event begins.

Work Zone Start Period

This is the beginning analysis period for the work zone event.
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